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W niniejszej instrukcji zastosowano przedstawione poniżej symbole ostrzegawcze. 

Przed rozpoczęciem używania urządzenia użytkownik powinien zapoznać się z nimi 

oraz ich znaczeniem. 

OSTRZEŻENIE 
OSTRZEŻENIE wskazuje użytkownikowi na występowanie ryzyka. 
Należy zwrócić szczególną uwagę na opis realizacji danej procedury 
i sposób jej wykonania, ponieważ nieprzestrzeganie opisanych 
zasad może doprowadzić do odniesienia obrażeń lub nawet śmierci 
użytkownika. Nie należy wykonywać czynności znajdujących się 
poza OSTRZEŻENIEM bez szczegółowego zapoznania się 
z zamieszczonym opisem i jego pełnego zrozumienia.  

 

 

UWAGA 
Symbol UWAGA wskazuje na możliwość wystąpienia ryzyka. Należy 
zwrócić uwagę na opis realizacji danej procedury i sposób jej wykonania, 
ponieważ nieprzestrzeganie opisanych zasad może doprowadzić do 
uszkodzenia urządzenia lub do utraty ważnych danych. Nie należy 
wykonywać czynności znajdujących się poza UWAGĄ bez 
szczegółowego zapoznania się z warunkami realizacji dalszych czynności 
i ich pełnego zrozumienia. 

 

 

INFORMACJA 
Symbol INFORMACJA wskazuje na podanie informacji, na którą 
użytkownik powinien zwrócić uwagę. Zawierać może ona dodatkowe 
instrukcje. 
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Widok ogólny oscyloskopu serii 1000 X 

 

Tabela 1 Podstawowe parametry oscyloskopów serii 1000 X 

Model EDUX1002A EDUX1002G DSOX1102A DSOX1102G 

Liczba kanałów 2 

Pasmo pracy 50 MHz 70 MHz (100 MHz z 
rozszerzeniem DSOX1B7T102) 

Szybkość próbkowania 1 GSa/s 2 GSa/s 

Pamięć 100 kpts 1 Mpts 

Segmentacja pamięci Nie Tak 

Generator przebiegów Nie Tak (20 MHz) Nie Tak (20 MHz) 

Testy z wykorzystaniem 
masek i linii limitów 

Nie Tak 

Oscyloskopy Keysight InfiniiVision serii 1000 X wyposażone zostały w: 

• Wyświetlacz o przekątnej 7 cali pracujący w rozdzielczości WVGA. 

• Szybkość odświeżania rzędu 50 000 przebiegów/sekundę. 

• Pokrętła wyposażone dodatkowo w funkcję szybkiego wyboru lub zatwierdzania 

wartości poprzez ich naciśnięcie. 

• Tryby wyzwalania: wyzwalanie pojedynczym zboczem lub zboczami impulsu, 

szerokością impulsu lub sygnałem wideo w przypadku modeli EDUX1000. 

Modele serii DSOX1000 dodatkowo posiadają funkcje wyzwalania: wzorcem, 

czasem narastania lub opadania impulsu, a także funkcję setup&hold. 
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• Dodatkowe opcje związane z dekodowaniem sygnałów i wyzwalaniem 

sygnałami w standardach: I2C, UART/RS232 w przypadku modeli EDUX1000 a 

modele DSOX1000 dodatkowo w standardach: CAN, LIN i SPI. 

• Funkcje matematyczne takie jak: sumowanie, odejmowanie, mnożenie, 

dzielenie, wykonywanie szybkiej transformaty Fouriera (w zakresie amplitudy 

i fazy) i filtr dolnoprzepustowy. 

• Ustawianie do 2 przebiegów referencyjnych w celu umożliwienia wykonania 

porównania z przebiegami z innych kanałów lub przebiegami uzyskanymi 

w wyniku przeprowadzenia operacji matematycznych. 

• Łatwy dostęp do wielu wbudowanych funkcji pomiarowych. 

• Modele oznaczone literą G posiadają dodatkowo wbudowany generator 

przebiegów funkcyjnych pozwalający na uzyskanie przebiegów: 

sinusoidalnego, prostokątnego, piłokształtnego, impulsowego, napięcia stałego 

i przebiegu szumowego. 

• Wbudowany interfejs USB pozwalający na łatwe drukowanie wyników 

pomiarów oraz zapisywanie i dzielenie się danymi. 

• Wbudowany w przyrząd system szybkiej pomocy Quick Help. Naciśnięcie 

i przytrzymanie dowolnego przycisku na panelu przednim przyrządu spowoduje 

wyświetlenie okna Quick Help. Więcej informacji na temat systemu pomocy 

można znaleźć w dalszych rozdziałach instrukcji.  

• Więcej szczegółowych informacji na temat oscyloskopów InfiniiVision można 

uzyskać na stronie firmy Keysight pod adresem www.keysight.com/find/scope  

 

 

http://www.keysight.com/find/scope
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1 ROZPOCZĘCIE PRACY Z PRZYRZĄDEM 

W rozdziale tym zostały opisane czynności, jakie użytkownik powinien wykonać przed 

pierwszym użyciem przyrządu. 

INFORMACJA  

Informacje podstawowe dotyczące występujących w przyrządzie przycisków funkcyjnych i przycisków 
kontekstowych. 

W niniejszej instrukcji zastosowano następujący sposób opisu naciskania sekwencji przycisków 
funkcyjnych i przycisków kontekstowych. Naciśnięcie kolejno przycisku funkcyjnego [Przycisk 
funkcyjny1] oraz naciśnięcie kolejno przycisków kontekstowych Przycisk kontekstowy2 i następnie 
Przycisk kontekstowy3 przedstawiane jest w postaci: 

Nacisnąć przyciski [Przycisk funkcyjny 1]>Przycisk kontekstowy2>Przycisk kontekstowy 3  

1.1 Sprawdzenie ukompletowania przyrządu 

Sprawdzenie 

opakowania 

transportowego 

Po otrzymaniu przesyłki z przyrządem należy w pierwszej kolejności 

sprawdzić, czy opakowanie nie posiada żadnych widocznych 

zewnętrznych uszkodzeń. W przypadku ich wystąpienia, należy 

zachować je, dopóki nie zostanie on sprawdzony pod względem 

mechanicznym i elektrycznym.  

W przypadku jakichkolwiek uszkodzeń mechanicznych widocznych na 

obudowie oscyloskopu należy jak najszybciej skontaktować się 

z najbliższym przedstawicielem lub dystrybutorem firmy Keysight. 

Opakowanie przyrządu należy przechowywać aż do przeprowadzenia 

sprawdzenia oscyloskopu przez przedstawiciela firmy Keysight 

Technologies. 

Sprawdzenie 

kompletności 

Należy sprawdzić, czy wraz z przyrządem dostarczono następujące 

wyposażenie podstawowe oraz zakupione dodatkowe akcesoria: 

• Oscyloskop InfiniiVision serii 1000 X  

• Przewód zasilania właściwy dla danego regionu 

• Dwie sondy do oscyloskopu 

1.2 Dołączenie zasilania do przyrządu 

Wymagania dla linii 

zasilającej 

• Napięcie zasilania w zakresie od 100-120 VAC, 50/60/400 Hz 

• Napięcie zasilające w zakresie od 100-240 VAC, 50/60 Hz 

• Maksymalne obciążenie 50 W 

Wymagania dotyczące 

przepływu powietrza 

wokół przyrządu 

Wloty i wyloty powietrza z przyrządu muszą być odsłonięte, bez 

zewnętrznych przeszkód blokujących swobodny przepływ powietrza 

w celu zapewnienia jego prawidłowego chłodzenia.  
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Zastosowany w przyrządzie wentylator wymusza przepływ powietrza 

wewnątrz przyrządu od dolnej lewej krawędzi przyrządu w kierunku 

górnej części obudowy aż na zewnątrz przyrządu.  

W przypadku konieczności zabudowy przyrządu np. w szafie 

pomiarowej, w celu zapewnienia właściwej wentylacji przyrządu, należy 

zapewnić co najmniej 5 cm przestrzeń po obu stronach przyrządu oraz 

10 cm wolnej przestrzeni za i ponad przyrządem. 

Włączenie zasilania 

przyrządu 

W celu włączenia zasilania przyrządu należy: 

1. Dołączyć do gniazda zasilania znajdującego się z tyłu przyrządu 

przewód zasilający. Przewód zasilania powinien być tak 

poprowadzony, żeby przyrząd nie przygniatał go. 

2. Wbudowany w oscyloskop zasilacz automatycznie wykryje wartości 

napięcia zasilania i odpowiednio dostosuje do niego swoje 

parametry pracy. 

OSTRZEŻENIE Dołączenie przyrządu do sieci energetycznej należy wykonywać 
zawsze za pomocą przewodu z uziemieniem. Nie wolno celowo 
odłączać uziemienia.  

 3. Nacisnąć przycisk włączenia zasilania 

Przycisk ten znajduje w lewym dolnym rogu panelu przedniego 

przyrządu. Po włączeniu zasilania oscyloskop w pierwszej 

kolejności przeprowadzi kilkusekundowy auto test, po którym 

przyrząd będzie gotowy do pracy.  

1.3 Dołączenie sond do przyrządu 

 1. Dołączyć sondy do kanałów przyrządu wyposażonych w gniazda 

typu BNC. 

2. Dołączyć zaciski sond do punktów, w których mają być dokonane 

obserwacje przebiegów lub pomiary z wykorzystaniem oscyloskopu. 

Należy upewnić się, że zacisk masy został prawidłowo dołączony do 

punktu masy badanego układu. 

UWAGA Należy zwrócić uwagę, żeby nie przekroczyć maksymalnej 
wartości napięcia, jakie może zostać podane na wejście 
analogowe oscyloskopu:  150 Vrms, 200 Vpk  

UWAGA Unikaj występowania efektu „pływającej” masy. 

Niedokładne połączenie masy badanego układu i problemy 
z „pływającą” masą spowodować mogą poważne niedokładności 
w pomiarach realizowanych za pomocą przyrządu, jak również mogą 
spowodować uszkodzenie przyrządu. Zacisk masy dołączony jest do 
chassis oscyloskopu oraz do zacisku uziemienia przewodu 
zasilającego. Jeżeli użytkownik chce dokonać pomiarów napięcia 
pomiędzy dwoma przewodami to należy posłużyć się sondą różnicową 
z odpowiednim zakresem dynamiki. 

 

OSTRZEŻENIE Nie odłączaj uziemienia od oscyloskopu. Przyrząd musi być 
dołączony do obwodu uziemienia przy wykorzystaniu przewodu 
zasilającego. Niedokładne uziemienie przyrządu stanowi 
zagrożenie wystąpienia porażenia elektrycznego użytkownika. 
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1.4 Podawanie sygnału przebiegu na wejście 
oscyloskopu 

 Sygnał Probe Camp jest wykorzystywany do kompensacji sond.  

1. Podłączyć zacisk sondy kanału nr 1 do zacisku Demo, Probe Comp 

na panelu przednim przyrządu. 

2. Dołączyć zacisk masy sondy do zacisku masy (znajdującego się 

obok zacisku Demo). 

1.5 Przywrócenie ustawień domyślnych przyrządu 

 W celu przywrócenia domyślnych ustawień przyrządu należy: 

1. Nacisnąć przycisk [Default Setup]. 

Wywołanie funkcji Default Setup powoduje przywrócenie 

domyślnych ustawień przyrządu. Po wykonaniu tej operacji przyrząd 

będzie posiadał ściśle określone ustawienia.  

W menu przywracania wartości domyślnych Save/Recall są również 

opcje pozwalające na całkowite przywrócenie ustawień przyrządu 

do wartości ustawionych podczas procesu produkcji oscyloskopu lub 

opcje pozwalające na wykonanie kasowania wszystkich danych 

zapisanych w przyrządzie z uwagi na względy bezpieczeństwa. 

1.6 Funkcja Auto Scale 

 W celu przeprowadzenia szybkiej, automatycznej konfiguracji 

parametrów przyrządu do parametrów zmierzonego sygnału można 

posłużyć funkcją automatycznego skalowania [Auto Scale]. W tym celu 

należy: 

1. Nacisnąć przycisk [Auto Scale] na panelu przednim przyrządu. 

Powinno to spowodować wyświetlenie przebiegu jak to 

przedstawiono na poniższym rysunku.  
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 2. Jeżeli użytkownik chce przywrócić ustawienia parametrów przyrządu 

do wartości ustawionych przed wykonaniem automatycznego 

skalowania należy nacisnąć przycisk [Undo Auto Scale]. 

 3. Jeżeli użytkownik chce uruchomić funkcję „szybkiego debugowania” 

automatycznego skalowania parametrów, zmienić skale dla kanału 

lub zabezpieczyć parametry związane z akwizycją danych 

pomiarowych podczas wykonywania funkcji automatycznego 

skalowania należy posłużyć się opcjami Fast Debug, Channels lub 

Acq Mode. 

Opcje te są dostępne, pod przyciskami kontekstowymi lub z poziomu 

menu Autoscale Preferences.  

Jeżeli użytkownik widzi na ekranie przebieg testowy, ale kształt fali 

prostokątnej nie jest odpowiednio ostry należy przeprowadzić procedurę 

kompensacji sondy zgodnie z opisem zawartym w rozdziale 

1.7 Kompensacja sond pasywnych. 

Jeżeli przebieg testowy nie jest wyświetlany należy upewnić się czy 

sonda została prawidłowo dołączona do gniazda wejściowego 

przyrządu oraz do zacisku Demo/Probe Comp. 

1.7 Kompensacja sond pasywnych 

Każda sonda pasywna dołączana do oscyloskopu musi zostać poddana procedurze 

kompensacji w celu dopasowania charakterystyki kanału wejściowego oscyloskopu do 

jej parametrów. Sondy, dla których nie przeprowadzi się procedury kompensacji, lub 

dla których procedura taka zostanie źle wykonana, mogą być źródłem istotnych błędów 

pomiarowych. 

Procedura kompensacji 

sond pasywnych 

1. Podać na wejście sondy sygnał służący do przeprowadzenia 

kompensacji Probe Comp. 

2. Nacisnąć przycisk [Default Setup] w celu przywrócenia ustawień 

domyślnych oscyloskopu.  

3. Nacisnąć przycisk [Auto Scale] w celu automatycznego ustawienia 

parametrów przyrządu do parametrów sygnału Probe Comp. 

4. Wybrać kanał, do którego jest dołączona sonda poprzez naciśnięcie 

przycisku [1] lub [2]. 

5. Z menu Channel wybrać opcję Probe. 

6. Z menu Channel Probe wybrać opcję Probe Check, a następnie 

postępować zgodnie z instrukcjami wyświetlanymi na ekranie 

oscyloskopu. 

Jeżeli jest to konieczne to należy wykorzystać niemetalowe 

narzędzia (dostarczone wraz z sondami) w celu przeprowadzenia 

regulacji parametrów pojemności wbudowanej w złącze BNC sondy 

(np. w sondzie N2140/42A), w celu uzyskania jak najbardziej 

płaskiego przebiegu na ekranie. 

W przypadku sond typu N2862/63/90 śruba regulacji pojemności 

oznaczona jest kolorem żółtym na obudowie sondy.  
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 7. Dołączyć sondę do pozostałych kanałów analogowych oscyloskopu. 

8. Powtórzyć procedurę kompensacji dla każdego z kanałów 

1.8 Elementy panelu przedniego przyrządu 

Podstawowymi elementami dostępnymi na panelu przednim przyrządu są przyciski 

funkcyjne oraz przyciski kontekstowe. 

Przyciski funkcyjne są to elementy służące do dokonywania wyboru konkretnych 

ustawień przyrządu poprzez ich naciśnięcie. Funkcje przycisków są precyzyjnie 

określone.  

Przyciski kontekstowe to sześć przycisków umieszczonych po prawej stronie ekranu 

oscyloskopu. Funkcje przycisków kontekstowych wyświetlane są na ekranie 

oscyloskopu i mogą się zmieniać w zależności od wcześniej wybranych opcji i funkcji 

przyrządu.  

Poniżej zaprezentowano i opisano poszczególne elementy znajdujące się na panelu 

przednim przyrządu. 

 

1. Włącznik zasilania W celu włączenia przyrządu należy nacisnąć przycisk włączenia 

zasilania. Powtórne naciśnięcie przycisku spowoduje wyłączenie 

przyrządu. 

Prawiłowa kompensacja

Zbyt duża kompensacja

Zbyt mała kompensacja

12. Grupa przycisków Waveform

11. Grupa elementów starowania 

wyzwalaniem - Trigger

7. Elementy starowania 

dla osi poziomej 
- Horizontal

8. Grupa elementów Run

5. Przycisk [Default Setup] 6. Przycisk [Auto Scale]

9. Elementy sterowania 
      pomiarami Measure

10. Przyciski grupy Tools

13. Przycisk [Help]

14. Przycisk [Bus]

16. Elementy
starowania dla osi 
pionowej Vertical

17. Wejścia
analogowe

19. Zaciski ,Demo
Probe Comp Groundi 

20. Porty USB 15. Wejście
EXT TRIG IN

18. Wyjście
generatora 
przebiegów

1. Włącznik zasilania

2. Przyciski kontekstowe

3. Przycisk [Intensity]

4. Pokrętło wielofunkcyjne
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2. Przyciski kontekstowe Funkcje tych przycisków zmieniają się w zależności od wybranej funkcji 

przyrządu. Każdorazowo opis ich funkcji wyświetlany jest na ekranie 

z lewej strony przycisków. 

Przycisk  pozwala na cofnięcie się na wyższy poziom menu. Jeżeli 

osiągnięto najwyższy poziom menu naciśnięcie przycisku  

spowoduje wyłączenie się menu kontekstowego, dzięki czemu 

powiększa się obszar roboczy oscyloskopu. 

3. Przycisk [Intensity] Naciśnięcie przycisku spowoduje podświetlenie przycisku. Poruszenie 

pokrętłem wielofunkcyjnym umożliwia dokonanie zmiany jasności 

wyświetlanych przebiegów. Użytkownik może dokonywać zmiany 

jasności przebiegów w celu uchwycenia szczegółów przebiegów 

podobnie jak to miało miejsce w oscyloskopach analogowych. 

4. Pokrętło 

wielofunkcyjne 

Pokrętło wielofunkcyjne jest wykorzystywane do dokonywania wyboru 

poszczególnych opcji menu oraz do zmian wartości parametrów. 

Funkcje realizowane przez pokrętło wielofunkcyjne są zależne od 

bieżącego ustawienia menu oraz ustawień dokonanych przy użyciu 

przycisków kontekstowych.  

Jeżeli pokrętło wielofunkcyjne może zostać wykorzystane do dokonania 

zmiany parametru lub jego wartości zostaje podświetlony symbol  

W wielu przypadkach wykorzystanie pokrętła wielofunkcyjnego jest 

wystarczające do dokonania wyboru właściwej funkcji lub wartości. 

Niekiedy zatwierdzenie dokonanego wyboru, zaznaczenie lub 

odznaczenie wybranej opcji odbywa się poprzez naciśnięcie pokrętła 

wielofunkcyjnego. Naciśnięcie przycisku pokrętła wielofunkcyjnego 

powoduje również wyłączenie pojawiających się okien menu. 

5. Przycisk [Default 

Setup] 

Przycisk ten służy do przywracania domyślnych ustawień oscyloskopu.  

6. Przycisk [Auto Scale] Przycisk ten służy do szybkiego określenia przez przyrząd, który kanał 

jest aktywny, włączenia zobrazowania dla tego kanału oraz 

dostosowania parametrów wyświetlania do jak najlepszej prezentacji 

wyników pomiarów.  

7. Grupa elementów 

starowania dla osi 

poziomej – Horizontal 

i sterowania akwizycja 

danych Acquisition 

W skład elementów sterowania dla osi poziomej wchodzą: 

• Pokrętło skali osi poziomej – w celu zmiany skali osi poziomej należy 

przekręcić w prawo lub w lewo pokrętło oznaczone piktogramem 

. Zmiana położenia pokrętła wpływa na szybkość czasu 

przemiatania, ponieważ dokonywania jest zmiana liczby podziałek 

przypadających na określony interwał czasowy. Symbole 

umieszczone poniżej pokrętła wskazują, że służy ono do 

rozciągania lub zacieśniania przebiegu w osi poziomej. 

Naciśnięcie pokrętła skali osi poziomej powoduje przełączanie 

pomiędzy regulacją dokładna i zgrubną. 

• Pokrętło położenia okna pomiarowego na osi poziomej – w celu 

zmiany położenia okna pomiarowego na osi poziomej należy 
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przekręcić w prawo lub w lewo pokrętło oznaczone piktogramem 

. Dzięki tej funkcji użytkownik może obserwować przebieg 

przechwycony przed wystąpieniem sygnału wyzwalającego pomiar 

(obrót pokrętła zgodnie z kierunkiem ruchu wskazówek zegara) lub 

może obserwować przebieg po wystąpieniu sygnału wyzwalającego 

(obrót pokrętła przeciwnie do kierunku ruchu wskazówek zegara). 

Jeżeli przyrząd nie pracuje w trybie wyzwalania ciągłego (Run), 

wtedy na ekranie oscyloskopu prezentowane są dane zebrane 

przez oscyloskop podczas ostatniego cyklu akwizycji danych 

pomiarowych.  

• Przycisk [Acquire] – naciśnięcie tego przycisku spowoduje 

otworzenie menu Acquire, w którym użytkownik może wybrać tryb 

Normal, tryb XY lub tryb Roll, a także włączyć lub wyłączyć funkcję 

Zoom, funkcję regulacji skali osi poziomej i może dokonać wyboru 

punktu referencyjnego dla wyzwalania.  

Użytkownik może również wybrać tryb akwizycji danych jako 

Normal, Peak Detect, Averaging lub High Resolution. 

W oscyloskopach serii DSOX1000 możliwe jest również włączenie 

segmentacji pamięci.  

• Przycisk Zoom  służący do przełączania trybu wyświetlania 

zobrazowania na ekranie oscyloskopu pomiędzy trybem normalnym 

(Normal) i powiększeniem (Zoom) bez konieczności zagłębiania się 

w menu Acquire.  

8. Grupa elementów 

Run  

Jeżeli przycisk [Run/Stop] podświetlony jest kolorem zielonym, to 

oznacza to, że przyrząd jest w trybie pomiarowym i dokonuje 

zapisywania danych pomiarowych, kiedy wystąpi zdarzenie 

wyzwalające. Zatrzymanie przechwytywania danych możliwe jest 

poprzez naciśnięcie przycisku [Run/Stop]. 

Jeżeli przycisk jest podświetlony kolorem czerwonym to oznacza to, że 

proces zbierania danych jest zatrzymany. Rozpoczęcie zbierania 

danych możliwe jest poprzez naciśnięcie przycisku [Run/Stop]. 

W celu przechwycenia i zobrazowania pojedynczego przebiegu 

(niezależnie od tego czy oscyloskop jest w trakcie pomiaru czy też nie) 

należy nacisnąć przycisk [Single]. W czasie wyzwolenia przycisk 

[Single] podświetlony jest kolorem żółtym. 

9. Grupa przycisków 

sterowania pomiarami 

W skład grupy przycisków służących do sterowania pomiarami znajdują 

się takie przyciski jak: 

[Analyze] – naciśniecie tego przycisku umożliwia dostęp do menu 

analizy, zapewniającego takie funkcje jak: ustawienie poziomu 

wyzwalania, ustawienie progu pomiarowego, ustawienie wyzwalania 

video oraz wyświetlania lub wybór funkcji cyfrowego miernika napięcia. 

Przycisk [Meas] pozwala na wybór predefiniowanych typów pomiarów.  

Przycisk [Cursor] dający dostęp do menu, za pomocą którego 

użytkownik może wybrać tryb pracy kursorów i źródła.  

Pokrętło kursorów – naciśnięcie pokrętła pozwala na wybranie 

kursorów z menu kontekstowego. Po zamknięciu się menu 

kontekstowego (po upływie określonego czasu lub po ponownym 
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naciśnięciu przycisku), obrót pokrętła umożliwia regulację położenia 

wybranego kursora. 

10. Przyciski grupy Tools W skład grupy Tools wchodzą następujące elementy: 

• Przycisk [Save/Recall] - naciśnięcie przycisku umożliwia zapis lub 

odczytanie ustawień przyrządu, zrzutu ekranu, przebiegu lub filtru 

maski czy przebiegu referencyjnego.  

• Przycisk [Utility] – pozwalający na dostęp do menu Utility, dzięki 

któremu można konfigurować parametry wejść i wyjść oscyloskopu, 

wykorzystywać okno eksploratora plików, ustawiać preferencje 

użytkownika, uzyskać dostęp do menu serwisowego, a także 

wybrać inne opcje.  

• Przycisk [Display] dający dostęp do menu, za pomocą którego 

użytkownik może aktywować poświatę ekranu, wyczyścić ekran, 

a także dokonać regulacji jasności siatki wyświetlanej na ekranie 

czy opisów przycisków kontekstowych i komunikatów. 

• Przycisk [Quick Action] – pozwala na wykonanie wybranych 

szybkich działań takich jak: pomiar wszystkich zrzutów, drukowanie, 

zapisywanie, odtwarzanie, zamrożenie ekranu i innych.  

• Przycisk [Save to USB] – naciśnięcie przycisku spowoduje szybki 

zapis na nośniku USB dołączonym do przyrządu. 

11. Grupa elementów 

starowania 

wyzwalaniem - 

Trigger 

Elementy sterowania znajdujące się w grupie Trigger pozwalają na 

określenie parametrów wyzwalania przyrządu wpływających na 

moment przechwytywania danych przebiegów wejściowych. W skład 

grupy Trigger wchodzą następujące elementy: 

• Pokrętło poziomu – służy do ustawiania poziomu wyzwalającego dla 

wybranego kanału analogowego.  

Naciśnięcie pokrętła spowoduje ustawienie poziomu wyzwalania na 

poziomie 50% amplitudy przebiegu. Jeżeli włączone jest sprzężenie 

AC, to nastąpi ustawienie poziomu wyzwalania na wartość 0 V. 

Położenie poziomu wyzwalania dla kanałów analogowych jest 

wskazywane przez ikonę poziomu  (jeżeli kanał analogowy jest 

włączony) znajdującą się po lewej stronie ekranu. Wartość poziomu 

wyzwalania dla kanału analogowego jest wyświetlana w prawym 

górnym rogu wyświetlacza. 

• Przycisk [Trig] – umożliwiający wybór typu wyzwalania (zboczem, 

szerokością impulsu, video itp.). Użytkownik może również 

skonfigurować dodatkowe opcje wspólne dla wszystkich typów 

wyzwalania. 

• Przycisk [Force] – umożliwia wyzwolenie pomiarów i wyświetlenie 

zebranych danych pomiarowych.  

Przycisk ten jest pomocny w trybie wyzwalania Normal, kiedy to 

akwizycja danych ma miejsce tylko w przypadku wystąpienia 

zdefiniowanych przez użytkownika warunków wyzwolenia pomiaru. 

W trybie tym, w przypadku braku wyzwolenia pomiaru (wskaźnik 

„Trig’d?” jest wyświetlony na ekranie), użytkownik może nacisnąć 

przycisk [Force] w celu wymuszenia wyzwolenia pomiarów 

i zaprezentowania w jaki sposób przedstawia się mierzony przebieg 

w takiej chwili. 
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• Przycisk [External] – naciśnięcie przycisku powoduje przejście do 

sekcji pozwalającej na zdefiniowanie opcji dotyczących parametrów 

wyzwalania zewnętrznym sygnałem wyzwalającym.  

12. Grupa przycisków 

Waveform 

Przycisk [FFT] – zapewnia dostęp do funkcji FFT zaimplementowanej 

w oscyloskopie. 

Przycisk [Math] – zapewnia dostęp do funkcji matematycznych 

(sumowanie, odejmowanie itd.) zaimplementowanych w oscyloskopie. 

Przycisk [Ref] – zapewnia dostęp do funkcji przebiegu referencyjnego. 

Przebieg referencyjny może zostać zapisany w pamięci przyrządu 

i następnie może być wyświetlany na ekranie w celu porównania z nim 

przebiegu zmierzonego lub przebiegu, na którym wykonano operacje 

matematyczne. 

Przycisk [Wave Gen] – przycisk występuje tylko w oscyloskopach serii 

G, w których wbudowany jest generator przebiegów. Pozwala on na 

uzyskanie dostępu do menu generatora przebiegów funkcyjnych. 

13. Przycisk [Help] Wywołuje menu Help pozwalające na wyświetlenie tematów opisanych 

w systemie pomocy przyrządu, a także na zmianę języka. 

14. Przycisk [Bus] Umożliwia wyświetlenie menu funkcji Bus, gdzie użytkownik może: 

• Wyświetlić elementy magistrali zbudowanej z wejść kanałów 

analogowych i wejścia sygnału zewnętrznego wyzwalania, gdzie 

wejście kanału nr 1 jest wejściem najmniej znaczącego bitu 

a wejście sygnału zewnętrznego wyzwalania jest wejściem 

najbardziej znaczącego bitu. 

• Włączyć dekodowanie transmisji dla magistrali szeregowej. 

15. Wejście EXT TRIG IN Wejście zewnętrznego sygnału wyzwalania pomiarów.  

16. Grupa elementów 

starowania dla osi 

pionowej Vertical 

W skład elementów sterowania dla osi pionowej wchodzą: 

• Przyciski włączania i wyłączania kanałów analogowych pozwalające 

na włączenie lub wyłączenie odpowiednich kanałów analogowych. 

Każdy z kanałów posiada swój indywidualny przycisk włączenia 

i wyłączenia kanału.  

• Pokrętła skali osi pionowej – w celu zmiany skali osi pionowej należy 

przekręcić pokrętło oznaczone piktogramem . Pokrętło takie 

znajduje się przy każdym kanale analogowym występującym 

w przyrządzie. Pozwala ono na zmianę na zmianę czułości toru 

odbiorczego, przez co wpływa na amplitudę przebiegu.  

Naciśnięcie pokrętła powoduje przełączanie się pomiędzy dokładną 

i zgrubną regulacją czułości.  

Domyślnym trybem zmiany czułości jest powiększanie czułości 

względem poziomu zera dla danego kanału. Użytkownik może to 

zmienić na powiększanie względem środka ekranu. 

• Pokrętła położenia okna pomiarowego na osi pionowej służące do 

dokonania zmiany położenia okna pomiarowego na osi pionowej. 

Pokrętła takie występują osobno dla każdego kanału analogowego.  
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Wartość bieżącego napięcia wyświetlana w prawym górnym rogu 

ekranu przedstawia różnicę napięć pomiędzy pionowym środkiem 

ekranu i poziomem uziemienia (ikona ).  

Reprezentuje ona również wartość napięcia dla środka osi pionowej, 

jeżeli powiększenie w osi pionowej jest ustawione na powiększenie 

wokół poziomu uziemienia. 

17. Wejścia analogowe Wejścia analogowe wyposażone w gniazda typu BNC pozwalają na 

dołączenie do oscyloskopu przewodów sygnałowych z wtykami typu 

BNC lub sond pomiarowych. Oscyloskopy InfiniiVision 1000 X 

posiadają impedancję wejściową dla wejść analogowych na poziomie 

1 MΩ. Przyrząd nie został wyposażony w układ do automatycznego 

wykrywania impedancji dołączonej sondy pomiarowej, zatem w celu 

uzyskania jak największej dokładności pomiarów użytkownik musi 

ręcznie dokonać właściwej regulacji impedancji wejściowej sondy.  

18. Wyjścia generatora 

przebiegów 

Modele oscyloskopów serii G z wbudowanym generatorem przebiegów 

funkcyjnych, wyposażone są dodatkowo w możliwość wyprowadzenia 

przebiegu generowanego (przebieg sinusoidalny, prostokątny, 

piłokształtny, impulsowy, przebieg stały DC lub szum) poprzez port ze 

złączem BNC oznaczony jako Gen Out. 

Użytkownik może również skierować do portu Gen Out sygnał 

wyzwalający lub sygnał informujący o odstępstwach mierzonego 

przebiegu od przebiegu zadanej maski wzorcowej. 

19. Zaciski Demo/Probe 

Comp i Ground 

• Zacisk Demo/Probe Comp – wyprowadza na zewnątrz przyrządu 

sygnał ProbeComp, który jest wykorzystywany do przeprowadzenia 

procedury dopasowanie pojemności wejściowej sondy pomiarowej 

do wejścia kanału pomiarowego (patrz rozdział 1.7 Kompensacja 

sond pasywnych). W zależności od warunków licencji na wyjściu 

tym mogą pojawiać się również sygnały pozwalające na 

demonstrowanie pracy przyrządu lub sygnały testowe.  

• Zacisk Ground – zacisk masy, który należy wykorzystywać przy 

podłączeniu sondy do zacisków Demo/Probe Comp. 

20. Porty USB Oscyloskop został wyposażony w port USB pracujący w trybie hosta 

umieszczony na panelu przednim przyrządu i port USB służący do 

połączenia przyrządu z portem USB stacji roboczej wyposażonej w port 

USB typu host.  

Port znajdujący się na panelu przednim przyrządu (USB Host) służy do 

dołączenia do przyrządu zewnętrznych pamięci masowych w celu 

zapisana lub wczytania do przyrządu plików zawierających dane 

konfiguracyjne przyrządu dla konkretnych pomiarów lub też do 

zapisania na nich zrzutów ekranów z przebiegami pomiarowymi. 

W celu wydrukowania wyników pomiarów wykonanych za pomocą 

oscyloskopu należy dołączyć do portu USB drukarkę.  

Port ten może być również wykorzystywany do uaktualniania 

oprogramowania systemowego oscyloskopu.  

Odłączenie dowolnego urządzenia wcześniej podłączonego do 

przyrządu nie wymaga podejmowania żadnych dodatkowych czynności 
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przez użytkownika. Należy po prostu odłączyć urządzenie od portu USB 

przyrządu. Jedynym ograniczeniem jest nieodłączanie nośnika pamięci 

w chwili wykonywania na nim operacji zapisu lub odczytu. 

Z odłączeniem nośnika należy odczekać aż do zakończenia bieżącej 

operacji wykonywanej z użyciem nośnika. 

UWAGA! Nie wolno dołączać do portu USB przyrządu pracującego 

w trybie hosta, portu komputera również pracującego w trybie 

hosta.  

Komputer PC wyposażony w porty USB pracujące w trybie hosta będą 

widziały przyrząd jako urządzenie zewnętrze. Dlatego do takiego 

podłączenia oscyloskopu należy wykorzystywać port USB znajdujący 

się na panelu tylnym przyrządu (port ten nie pracuje w trybie hosta).  
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1.9 Elementy panelu tylnego przyrządu 

Poniżej zaprezentowano i opisano elementy znajdujące się na panelu tylnym 

przyrządu. 

 

1. Złącze zasilania  Służy do dołączenia do przyrządu przewodu zasilającego 

wyposażonego w przewód ochronny. 

2. Złącze Kensington Miejsce dołączenia blokady Kensington pozwalającej na fizyczne 

zabezpieczenie przyrządu. 

3. Port USB Device Port USB służący do podłączenia oscyloskopu do komputera PC 

pracującego jako host. Dzięki temu możliwe jest sterowanie 

oscyloskopem za pomocą komend wydawanych z poziomu komputera. 

 

  

3. Port USB (urządzenie)

1. Gniazdo zasilania

2. Otwór blokady Kensington
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1.10 Zapoznanie się z elementami wyświetlanymi na 
ekranie oscyloskopu 

Poniżej omówione zostaną podstawowe elementy zobrazowania oraz ich 

rozmieszczenie na ekranie oscyloskopu. 

 

Pasek statusu Obszar w górnej części ekranu, na którym prezentowane są informacje 

dotyczące ustawień dla osi pionowej i poziomej zobrazowania oraz 

ustawienia wyzwalania. 

Obszar wyświetlania 

przebiegów 

W obszarze wyświetlania prezentowane są przebiegi zmierzone przez 

oscyloskop, informacje dotyczące identyfikacji poszczególnych 

kanałów, a także wskaźnik poziomu odniesienia. Informacje dotyczące 

każdego z kanałów analogowych prezentowane są w innym kolorze. 

Szczegóły poszczególnych przebiegów wyświetlane są przy 

wykorzystaniu aż 256 poziomów intensywności.  

Pasek boczny z 

etykietami przycisków 

kontekstowych i polami 

informacyjnymi 

Pasek boczny znajdujący się po prawej stronie ekranu służy do 

prezentacji etykiet przycisków kontekstowych umieszczonych przy 

prawej krawędzi ekranu. Opisy przycisków zmieniają się zależnie od 

wybranej w danej chwili funkcji. Zwykle przyciski kontekstowe 

pozwalają użytkownikowi na uzyskanie prostego i szybkiego dostęp do 

parametrów wybranych funkcji lub włączonych trybów pracy przyrządu.  

Każdorazowe naciśnięcie przycisku  powoduje powrót do 

wyższego poziomu w hierarchii menu aż do chwili wygaszenia etykiet 

przycisków kontekstowych i wyświetlenia obszaru informacyjnego 

dotyczącego zmierzonych przebiegów i przebiegu referencyjnego. 

Użytkownik może również określić czas po jakim nastąpi wygaszenie 

etykiet przycisków kontekstowych (opcja [Utility]>Options>Menu 

Timeout). 

W przypadku naciśnięcia przycisku  w chwili, gdy zamiast etykiet 

przycisków kontekstowych wyświetlany jest obszar informacyjny 

powoduje powrót do wyświetlania najczęściej prezentowanego menu.  

Czułość kanału 
analogowego

Punkt 
wyzwalania,
referencyjny 

czas Opóźnienie

Skala 
czas/działkę Status 

Run/Stop

Typ 
sygnału 

wyzwalania

Źródło sygnału wyzwlania

Poziom wyzwalania

Informacyjny pasek boczny
oraz obszar wyświetlania 
elementów sterowania

Pomiary

Kursory określające pomiary

Inne przebiegi

Kanały analogowe
oraz poziom 
odniesienia

Poziom wyzwalania

Obszar statusu
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Obszar prezentacji 

danych pomiarowych 

W chwili uruchomienia pomiarów lub włączenia funkcji kursorów 

w obszarze tym prezentowane są bieżące wyniki pomiarów i wartości 

wskazywane przez kursory.  

Jeżeli pomiary są wyłączone to w obszarze tym prezentowane są 

informacje dotyczące bieżącego statusu urządzenia i inne parametry 

konfiguracyjne. 

1.11 Dostęp do wbudowanego systemu szybkiej pomocy 
Quick Help 

Wyświetlenie informacji 

typu Quick Help 

1. Nacisnąć i przytrzymać dowolny przycisk lub przycisk kontekstowy, 

dla którego chcemy wyświetlić informacje systemu pomocy.   

 Okno informacji Quick Help zostanie wyświetlone na ekranie 

oscyloskopu i będzie widoczne aż do chwili naciśnięcia dowolnego 

przycisku lub poruszenia pokrętła funkcyjnego. 

Ustawienie języka dla 

elementów interfejsu 

użytkownika oraz dla 

systemu szybkiej 

pomocy Quick Help 

W celu dokonania wyboru języka dla interfejsu użytkownika oraz 

systemu szybkiej pomocy należy: 

1. Nacisnąć przycisk [Help], a następnie przycisk kontekstowy 

Language. 

2. Za pomocą pokrętła wielofunkcyjnego wybrać żądany język 

interfejsu użytkownika oraz języka dla systemu pomocy. 
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2 URUCHOMIENIE I ZATRZYMANIE POMIARÓW 

ORAZ WYKONANIE POJEDYNCZEGO 

PRZEBIEGU POMIAROWEGO 

Do zobrazowania wyników wielu różnych akwizycji tego samego sygnału należy 

wykorzystać funkcję poświaty (patrz rozdział „Ustawienia parametrów wyświetlania”). 

Pojedynczy przebieg a 

uruchomienie 

pomiarów i zapisanie 

zbioru danych o 

określonej długości 

Maksymalna wielkość rekordu danych zbieranych przy uruchomieniu 

pojedynczego przebiegu pomiarowego (Single) jest znacznie większa 

niż przy uruchomieniu pomiarów w trybie ciągłym (Running) za pomocą 

oscyloskopu (lub po jego zatrzymaniu po uruchomieniu pomiarów): 

Single – pojedynczy przebieg pomiarowy (pojedyncza akwizycja) 

zawsze wykorzystuje maksymalna dostępną pamięć – nawet dwa 

razy większą niż w przypadku przechwytywania wyników 

pomiarowych w trybie uruchomienia pomiarów (Running) 

i oscyloskop zapisuje w trybie Single dwa razy więcej próbek 

pomiarowych. Przy ustawieniu wolnego przebiegu pomiarów 

(ustawienie czasu na podziałkę) z uwagi na fakt, że w trybie Single 

jest dostępny większy obszar pamięci dla pojedynczej akwizycji 

zbieranie wyników pomiarów odbywa się z wyższą efektywną 

szybkością próbkowania.  

Running – po uruchomieniu pomiarów (w przeciwieństwie do trybu 

pracy Single) dostępna pamięć jest dzielona na połowę. Zabieg ten 

pozwala systemowi akwizycji na przetwarzanie jednego rekordu 

danych, podczas gdy zapisywany jest już kolejny rekord danych 

pomiarowych w drugim obszarze pamięci. Powoduje to istotny 

wzrost liczby przebiegów wykonywanych i przetwarzanych przez 

oscyloskop. Uruchomienie pomiarów za pomocą funkcji Running 

można osiągnąć najwyższą szybkość odświeżania mierzonego 

przebiegu dającą bardzo dobre odzwierciedlenie przebiegu sygnału 

wejściowego. 

W celu wykonania pomiaru i zgromadzenia jak najdłuższego rekordu danych należy 

nacisnąć przycisk [Single]. 

Tabela 2 Funkcje uruchamiające akwizycję danych pomiarowych 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Uruchomienie akwizycji [Run/Stop] – w chwili uruchomienia akwizycji przycisk jest podświetlany 
kolorem zielonym 

Zatrzymanie akwizycji [Run/Stop] – przycisk jest podświetlony kolorem czerwonym w chwili 
zatrzymania akwizycji 

Pojedyncza akwizycja [Single] – przycisk podświetlany jest kolorem żółtym aż do chwili, gdy 
nastąpi wyzwolenie pomiaru. 

Jeżeli nie wystąpi wyzwolenie pomiaru warunkiem ustawionym 
w oscyloskopie, użytkownik może wymusi wyzwolenie pomiaru 
naciskając przycisk [Force Trigger]  
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3 ELEMENTY STEROWANIA DLA OSI 

POZIOMEJ 

3.1 Pokrętła i przyciski sterowania dla osi poziomej 

 

3.2 Przyciski kontekstowe sterowania dla osi poziomej 

Na poniższym rysunku przedstawiono elementy menu akwizycji danych, które 

wyświetla się po naciśnięciu przycisku [Acquire]. 

 

 

  

Punkt 
wyzwalania

Referencyjny
czas Opóźnienie

Skala 
czas/działkę

Tryb pracy dla
osi czasu: Normal

Tryb XY lub Roll

Źródło
sygnału 

wyzwalania
Poziom lub próg

wyzwalania 

Powiększenie podstawy 
czasu

Położenie na osi X

punktu czasu 
referencyjnego
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3.3 Wykonywanie regulacji skali osi poziomej 

Symbol  znajdujący się u góry ekranu wskazuje punkt referencyjny dla osi czasu. 

Obrót pokrętłem skali osi poziomej spowoduje rozszerzenie lub zagęszczenie 

przebiegu na osi czasu. 

Położenie punktu określającego czas odniesienia (t=0) jest wskazywane u góry 

zobrazowania poprzez symbol wypełnionego trójkąta (▼). 

Czas opóźnienia określa zwłokę dzielącą czas, kiedy nastąpiło wyzwolenie pomiaru 

i czas odniesienia. 

Poruszenie pokrętła położenia okna pomiarowego na osi poziomej, oznaczonego 

piktogramem , powoduje zmianę położenia punktu wyzwalania. 

Menu Acquire pozwala użytkownikowi na wybór trybu pracy dla osi czasu. Dostępne 

są tryby: Normal, XY lub Roll. Za pomocą menu możliwe jest również włączenie okna 

powiększenia dla osi czasu, precyzyjna kontrola podstawy czasu z wykorzystaniem 

noniusza i określenie czasu odniesienia. 

Tabela 3 Podstawowe funkcje dostępne dla osi poziomej 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Tryb pracy dla osi czasu - 
Time mode 

[Acquire]>Time mode (Normal, XY, Roll) 

Tryb XY [Acquire]>Time mode, XY 

Kanał nr 1 stanowi port wejściowy dla przebiegu osi poziomej, kanał nr 
2 jest portem wejściowym dla przebiegu osi pionowej. Oś Z definiowana 
jest przez sygnał wyzwolenia pomiaru pojawiający się na wejściu (Ext 
Trig) – powoduje włączenie lub wyłączenie zobrazowania przebiegu. 
Jeżeli poziom na wejściu Ext Trig (oś Z) jest niski (<1,4 V), to na ekranie 
prezentowany jest przebieg Y względem przebiegu X. W chwili, gdy na 
wejściu Ext Trig pojawia się przebieg wysoki (>1,4 V) przebieg jest 
wygaszany.  

Jednym z najczęściej wykonywanych pomiarów jest pomiar różnicy faz 
pomiędzy dwoma sygnałami o tej samej częstotliwości za pomocą 
metody Lissajous. Więcej na ten temat można znaleźć w pozycji "XY 
Display Mode Example" dostępnej na stronie 
www.keysight.com/find/xy-display-mode ). 

Tryb Roll [Acquire]>Time mode, Roll 

Zoom 
[Acquire]>Zoom lub naciśnięcie przycisku  

Położenie czasu 
odniesienia - Time 
references 

[Acquire]>Time Ref (Left, Center, Right) 

 

  

http://www.keysight.com/find/xy-display-mode
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3.4 Funkcja Zoom 

Funkcja Zoom pozwala na wyświetlenie na części ekranu okna funkcji Zoom, w którym 

znajduje się powiększony fragment mierzonego przebiegu zobrazowanego 

w standardowym oknie. W celu włączenia (lub wyłączenia) funkcji Zoom należy 

nacisnąć przycisk oznaczony symbolem  lub też z poziomu menu [Acquire] należy 

nacisnąć przycisk kontekstowy Zoom.  

 

  

Okno Zoom

Anomalia sygnału 
widoczna 

w oknie Zoom

Okno standardowego
widoku przebiegu

Markery wskazujące
początek i koniec

zobrazowania widocznego
w oknie Zoom

Włączenie okna Zoom

Skala 
czas/działkę

dla okna Zoom

Skala 
czas/działkę

dla okna Normal Wielkość opóźnienia wyświetlania,

gdy pokrętło sterowania położeniem 
w poziomie jest włączone
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4 ELEMENTY STEROWANIA DLA OSI 

PIONOWEJ 

4.1 Pokrętła i przyciski sterowania dla osi pionowej 

 

4.2 Przyciski kontekstowe do sterowania dla osi 
pionowej 

Na poniższym rysunku przedstawiono elementy menu dla kanału nr 1, które 

wyświetlane są po naciśnięciu przycisku [1]. 

 

Punkt 
wyzwalania

Referencyjny
czas Opóźnienie

Skala 
czas/działkę

Tryb pracy dla
osi czasu: Normal

Tryb XY lub Roll

Źródło
sygnału 

wyzwalania
Poziom lub próg

wyzwalania 

Powiększenie podstawy 
czasu

Położenie na osi X

punktu czasu 
referencyjnego
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Poziom uziemienia dla sygnału dla każdego z wyświetlanych kanałów analogowych 

jest wskazywany przez znacznik  po lewej stronie ekranu. 

Tabela 4 Podstawowe funkcje dostępne dla osi pionowej 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Sprzężenie kanałów – 
Channel coupling 

[1/2] > Coupling (DC lub AC) 

Należy zwrócić uwagę, że funkcja Channel Coupling jest niezależna od 
funkcji Trigger Coupling. 

Ograniczenia pasma dla 
kanału - Channel 
bandwidth limit 

[1/2] > BW Limit 

Precyzyjna regulacja skali 
dla osi pionowej 

[1/2] > Fine 

Channel Invert - 
odwrócenie mierzonych 
przebiegów 

[1/2] > Invert 
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5 KONFIGUROWANIE OPCJI DLA SOND 

DOŁĄCZANYCH DO KANAŁÓW 

ANALOGOWYCH 

Naciśnięcie przycisku kontekstowego Probe z poziomu menu Channel powoduje 

otworzenie menu Channel Probe.  

Menu to pozwala użytkownikowi na konfigurowanie dodatkowych parametrów sond 

takich jak współczynniki tłumienia i jednostki w jakich odbywają się pomiary za pomocą 

określonej sondy dołączonej do przyrządu. 

UWAGA 
W celu wykonania dokładnych pomiarów konieczne jest właściwe 
dopasowanie współczynnika tłumienia dla sondy ustawionego 
w przyrządzie ze współczynnikiem tłumienia wykorzystywanej sondy 
pomiarowej.  

Tabel 5 Funkcje menu Probe 

Widok menu Channel 
Probe 

Funkcja 
Przycisk panelu przedniego lub 

umiejscowienie przycisku kontekstowego 

 

Units – jednostki dla 
kanału 

[1/2] > Probe > Units (Volts, Amps) 

Probe – tłumienie 
sondy 

[1/2] > Probe > Probe, Ratio/Decibels i pokrętło 

wielofunkcyjne  

Channel Skew [1/2] > Probe > Skew i pokrętło wielofunkcyjne 

 

Probe check [1/2] > Probe > Probe Check 

Umożliwia przeprowadzenie użytkownika przez 
proces kompensacji dla sond typu: N2140A, 
N2142A, N2862A/B, N2863A/B, N2889A, 
N2890A, 10073C, 10074C lub 1165A). 
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6 WYŚWIETLANIE DLA FUNKCJI ANALOG 

BUS 

Użytkownik może włączyć funkcję Analog Bus, w której szyną danych będą wejścia 

kanałów analogowych oraz gniazdo zewnętrznego sygnału wyzwalającego. Do funkcji 

Analog Bus dołączone mogą zostać dowolne wejścia kanałów analogowych. Wynik 

pomiaru dla szyny analogowej prezentowany jest na ekranie w dolnej części siatki. 

Kanał nr 1 to najmniej znaczący bit natomiast na złącze zewnętrznego sygnału 

wyzwalającego podawany jest sygnał najbardziej znaczącego bitu. 

Tabela 6 Funkcje dostępne dla wyświetlania wyników pomiarów za pomocą funkcji Analog Bus 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Analog Bus - wyświetlanie [Bus] > Display 

[Bus] > Select, pokrętło wielofunkcyjne , wybrać Analog Bus, 
nacisnąć przycisk kontekstowy Select lub pokrętło wielofunkcyjne w 
celu włączenia lub wyłączenia funkcji 

Analog Bus – przypisanie 
kanałów [Bus] > Channel, pokrętło wielofunkcyjne , ustawić wybór i poprzez 

naciśnięcie pokrętła wybrać lub usunąć przypisanie 

Analog Bus – wybór 
systemu prezentacji 
danych 

[Bus] > Base, pokrętło wielofunkcyjne  ,wybrać system w jakim 
prezentowane będą wyniki (Hex lub Binary) 

Analog Bus – wartość 
progowa dla kanału nr 1 

[Bus] > Ch1 Threshold, pokrętło wielofunkcyjne, nacisnąć w celu 
ustawienia wartości 0V 

Analog Bus – wartość 
progowa dla kanału nr 2 

[Bus] > Ch2 Threshold, pokrętło wielofunkcyjne, nacisnąć w celu 
ustawienia wartości 0V 

Analog Bus – wartość 
progowa dla wejścia 
zewnętrznego sygnału 
wyzwalającego 

[Bus] > Ext Threshold, pokrętło wielofunkcyjne, nacisnąć w celu 
ustawienia wartości 0V 
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7 ANALIZA WIDMOWA PRZY 

WYKORZYSTANIU SZYBKIEJ 

TRANSFORMATY FOURIERA (FFT) 

Funkcja FFT jest wykorzystywana do wykonywania szybkiej transformaty Fouriera 

przy wykorzystaniu sygnałów z kanałów analogowych. 

Przyrząd za pomocą funkcji FFT przekształca cyfrowo zapisany sygnał w dziedzinie 

czasu na jego reprezentację w dziedzinie częstotliwości. Po wybraniu funkcji FFT 

na ekranie oscyloskopu prezentowany jest przebieg amplitudy widma sygnału w dBV 

w funkcji częstotliwości. Jednostki na osi poziomej zmieniają się z czasu na 

częstotliwość (Hz), a na osi pionowej z V na dB. 

Funkcja FFT pomocna jest w analizie problemów związanych z przesłuchami, przy 

wykrywaniu zaburzeń w przebiegu analogowym, którego przyczyną jest nieliniowość 

wzmacniacza lub złe dostrojenie filtrów analogowych. 

Tabela 7 Opcje dostępne dla funkcji FFT 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

FFT span/center [FFT] > Span 

[FFT] > Center 

Okno FFT  [FFT] > Settings > Window, (dostępne ustawienia to Hanning, Flat Top, 
Rectangular, Blackman Harris)  

Jednostki dla osi pionowej [FFT] > Settings > Vertical Units (Decibels, VRMS)  

Automatyczna 
konfiguracja FFT 

[FFT] > Settings > Auto Setup 

Skala dla przebiegu FFT 
[FFT] > Scale, pokrętło wielofunkcyjne  

Offset dla przebiegu FFT 
[FFT] > Offset, pokrętło wielofunkcyjne  

7.1 Wskazówki dotyczące pomiarów z wykorzystaniem 
funkcji FFT 

Maksymalna liczba punktów na jakiej możliwe jest wykonanie funkcji FFT wynosi 

65 536, przy czym wszystkie punkty będą wyświetlane w chwili, gdy zakres 

prezentowanych częstotliwości jest maksymalny. Po wyświetleniu na ekranie 

oscyloskopu widma częstotliwości, zmiana zakresu częstotliwości i ustawienie 

częstotliwości środkowej odbywa się w sposób zbliżony do tego jak reguluje się te 

parametry w analizatorze widma. W celu szczegółowej obserwacji określonego 

zakresu częstotliwości należy interesującą użytkownika częstotliwość umieścić jako 
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częstotliwość środkową w centralnej części ekranu, a następnie zawęzić pasmo 

prezentowanych częstotliwości w celu zwiększenia rozdzielczości wyświetlacza. 

W miarę zawężania pasma częstotliwości liczba prezentowanych punktów będzie 

mniejsza. 

Przy wyświetlaniu widma sygnału do przełączania się pomiędzy funkcjami służącymi 

do pomiaru wartości, a funkcjami służącymi do zmiany parametrów dziedzinie 

częstotliwości służą przyciski [FFT] i [Cursors]. 

INFORMACJA 
Rozdzielczość funkcji FFT 

Rozdzielczość funkcji FFT jest ilorazem szybkości próbkowania i liczby 
punktów FFT (fS/N). 

Przy ustalonej liczbie punktów branych do analizy FFT (do 65 536 
punktów) im niższa szybkość próbkowania tym lepsza jest rozdzielczość 
uzyskanego przebiegu. 

 

 

Zmniejszając efektywną szybkość próbkowania poprzez zwiększenie ustawienia 

czas/działkę poprawiamy rozdzielczość dla niskich częstotliwości, ale jednocześnie 

zwiększamy możliwość występowania efektu aliasingu. Rozdzielczość transformaty 

FFT jest zależna od stosunku szybkości próbkowania do liczby punktów transformaty. 

Rzeczywista rozdzielczość jest jednak inna z powodu kształtu okna pomiarowego, 

które jest czynnikiem ograniczającym zdolność funkcji FFT do wydzielenie dwóch 

blisko położonych częstotliwości. W takim przypadku dobrym sposobem na 

przetestowanie rozdzielczości transformaty FFT pozwalającej na wykrycie dwóch 

częstotliwości znajdujących się blisko siebie jest podanie sygnału sinusoidalnego z 

modulacją amplitudy. 

Dla uzyskania najlepszej dokładności przy pomiarach amplitud sygnałów 

należy: 

• Upewnić się, że prawidłowo zostało ustawione tłumienie sondy. Wartość tłumienia 

ustawiana jest w menu Channel. 

• Ustawić czułość kanału w taki sposób, żeby sygnał wejściowy rozciągnięty był na 

cały ekran, ale żeby nie był przycięty (ustawić maksymalną dynamikę). 

• Posługiwać się oknem pomiarowym typu Flat Top. 

• Ustawić czułość transformaty FFT na około 2dB/ działkę. 
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Dla uzyskania najlepszej dokładności przy pomiarach częstotliwości 

występujących maksimów należy: 

• Posługiwać się oknem pomiarowym typu Hanning. 

• Wykorzystywać funkcje Cursors do ustawienia wskaźnika X na interesującej nas 

częstotliwości. 

• Dokonać regulacji szerokości pasma częstotliwości do dokładniejszego ustawienia 

kursora. 

• Po regulacji szerokości pasma powrócić do menu Cursors w celu dokładnego 

ustawienia kursora X na interesującej nas częstotliwości. 

Więcej informacji na temat funkcji FFT można znaleźć w nocie aplikacyjnej nr 243 

zatytułowanej „The Fundamentals of Signal Analysis” dostępnej pod adresem: 

http://literature.cdn.keysight.com/litweb/pdf/5952-8898E.pdf lub w rozdziale 4 książki 

„Spectrum and Network Measurements” by Robert A. Witte.   

7.2 Wartość napięcia stałego DC a FFT 

Funkcja FFT daje na wyjściu niepoprawną wartość składowej stałej. Wartość tego 

offsetu nie jest brana pod uwagę przy obliczeniach dla środka ekranu. Wartość 

ta jednak nie jest korygowana z uwagi na konieczność zapewnienia właściwej 

reprezentacji składowych częstotliwości bliskich składowej stałej. 

7.3 Zjawisko aliasingu 

Przy wykorzystywaniu funkcji FFT ważne jest unikanie występowania efektu aliasingu. 

Wymaga to od operatora posiadania pewnej wiedzy na temat tego jak powinna 

wyglądać dziedzina częstotliwości dla przekształcanego sygnału, a także jak dobrać 

szybkość próbkowania i pasmo oraz dynamikę dla osi pionowej przy wykonywaniu 

pomiarów z wykorzystaniem funkcji FFT. Rozdzielczość dla funkcji FFT jest 

wyświetlana w pasku umieszczonym bezpośrednio nad opisami przycisków 

kontekstowych, jeżeli wyświetlane jest menu funkcji FFT. 

INFORMACJA Kryterium Nyqiust i występowanie ząbkowania przebiegu 
w dziedzinie częstotliwości 

Częstotliwość Nyquista jest to maksymalna częstotliwość składowych 
widmowych sygnału poddawanego procesowi próbkowania, które mogą 
zostać odtworzone z ciągu próbek bez zniekształceń. Częstotliwość ta jest 
równa połowie częstotliwości próbkowania. Składowe widmowe 
o częstotliwościach wyższych od częstotliwości Nyquista ulegają podczas 
próbkowania nałożeniu na składowe o innych częstotliwościach (zjawisko 
aliasingu), co powoduje, że nie można ich już poprawnie odtworzyć. 

 

 

  

http://literature.cdn.keysight.com/litweb/pdf/5952-8898E.pdf
http://pl.wikipedia.org/wiki/Cz%C4%99stotliwo%C5%9B%C4%87
http://pl.wikipedia.org/wiki/Widmo_akustyczne
http://pl.wikipedia.org/wiki/Pr%C3%B3bkowanie
http://pl.wikipedia.org/wiki/Aliasing_(przetwarzanie_sygna%C5%82%C3%B3w)
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Zjawisko aliasingu ma miejsce, gdy w sygnale występują składowe częstotliwości 

większe niż połowa częstotliwości próbkowania. Ponieważ widmo sygnału uzyskanego 

za pomocą funkcji FFT jest ograniczone przez tę częstotliwość, to składowe 

o wyższych częstotliwościach ulegają nałożeniu na składowe o częstotliwościach 

niższych. 

Na przedstawionym poniżej rysunku zaprezentowano zjawisko aliasingu. Jest to 

widmo sygnału fali prostokątnej o częstotliwości 990 Hz, które posiada wiele 

harmonicznych. Ustawienie skali czasu dla osi poziomej (czas/działkę) dla przebiegu 

prostokątnego powoduje ustawienie częstotliwości próbkowania i rozdzielczości dla 

funkcji FFT na poziomie 1,91 Hz. Przedstawione na ekranie widmo zawiera 

komponenty sygnału wejściowego o częstotliwości większej niż częstotliwości 

Nyquista, dlatego następuje ich, jak gdyby zwierciadlane odbicie od prawej krawędzi 

ekranu. 

 

7.4 Wycieki widma przy FFT 

Wykorzystanie transformaty FFT bazuje na założeniu, że odcinki czasu powtarzają się, 

czyli że jest to sygnał okresowy. Jeżeli w zapisanym rekordzie nie występuje całkowita 

liczba okresów sygnału, to pojawią się nieciągłości sygnału. Określa się je mianem 

wycieku widmowego. W celu zminimalizowania efektu wycieku widma w oscyloskopie 

zaimplementowano cztery typy funkcji okien: Okno Hanninga, typu Flat Top, 

Prostokątne i okno Blackmana-Harrisa.  
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8 WYŚWIETLANIE PRZEBIEGÓW Z 

FUNKCJAMI MATEMATYCZNYMI 

Opcje, w które został wyposażony oscyloskop pozwalają użytkownikowi na 

wyświetlenie na ekranie wyników prostych operacji matematycznych na danych 

zebranych z kanałów analogowych. Przebieg taki prezentowany jest zawsze w kolorze 

jasnej purpury. 

Tabela 8 Dostępne w oscyloskopie funkcje matematyczne 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Operatory matematyczne [Math] > Operator (Add, Substract, Multiply, Divide, FFT Magnitude, 
FFT Phase, Low Pass Filter) 

Funkcje kaskadowe [Math] > Source 

Skala dla przebiegu z 
funkcją matematyczną [Math] > Scale, pokrętło wielofunkcyjne  

Offset dla przebiegu z 
funkcja matematyczną [Math] > Offset, pokrętło wielofunkcyjne  

PORADA 
Jeżeli zmierzony przebieg analogowy lub przebieg prostej funkcji 
matematycznej jest przycięty (nie mieści się cały na ekranie 
oscyloskopu), to po wykonaniu operacji matematycznej na takim 
przebiegu wynik również będzie wynikiem przyciętym. 
Po wyświetleniu funkcji, przebieg kanału analogowego może zostać 
wyłączony w celu uzyskania lepszego zobrazowania uzyskanych 
wyników przekształceń matematycznych.  
Pomiary wartości na przebiegach, dla których dokonano operacji 
matematycznych mogą być realizowane przy użyciu przycisków 
[Cursors] i/lub [Meas]. 

 

Tabela 9 Amplituda i faza dla funkcji FFT 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Automatyczna 
konfiguracja 

[Math] > Auto Setup 

Span/Center [Math] > More > Span 

[Math] > More > Center 

Funkcje okna 
transformaty 

[Math] > More > Window (Hanning, Flat Top, Rectangular, Blackman 
Harris) 

Jednostki dla osi pionowej [Math] > More > Vertical Units (dla amplitudy FFT: Decibels lub V RMS 
oraz dla fazy FFT: Radians lub Degrees). 

Punkt referencyjny fazy 
dla FFT 

[Math] > More > Zero Phase Ref (Trigger, Entire Display) 

Tabela 10 Operator dostępny dla funkcji Low Pass Filter 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Częstotliwość odcięcia dla 
filtru dolnoprzepustowego 

[Math] > Bandwidth 
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9 JEDNOSTKI DLA FUNKCJI 

MATEMATYCZNYCH 

 Jednostki dla każdego z kanałów wejściowych mogą zostać ustawione 

jako jednostki napięcia [V] lub prądu [A] za pomocą przycisku 

kontekstowego Units w menu Probe dla kanału. Dla funkcji 

matematycznych dostępne są następujące jednostki: 

Funkcja matematyczna Jednostki 

Dodawanie lub odejmowanie V lub A 

Mnożenie V2, A2, lub W (VoltoAmpery) 

FFT Amplituda dB lub V RMS 

FFT Faza Stopnie lub radiany 

W przypadku, gdy do wykonania operacji matematycznych 

wykorzystano dwa przebiegi źródłowe o różnych jednostkach, to 

przebieg wynikowy nie posiada zdefiniowanej jednostki – na ekranie 

pojawi się napis U. 
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10 PRZEBIEGI REFERENCYJNE 

Przebiegi zarejestrowane w kanałach analogowych lub przebiegi uzyskane w wyniku 

zrealizowania operacji matematycznych na danych mogą zostać zapisane w jednym 

z dwóch rejestrów przebiegów referencyjnych oscyloskopu. Następnie przebieg 

referencyjny może być wyświetlany na ekranie oscyloskopu i porównywany z innymi 

przebiegami bieżącymi. Równocześnie może być prezentowany tylko jeden przebieg 

referencyjny.  

Tabela 11 Funkcje dostępne dla przebiegu referencyjnego 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Wyświetlanie przebiegu 
referencyjnego 

[Ref] > Display Ref 

Zapisywanie przebiegu 
jako referencyjny 

[Ref] > Save/Clear > Source, [Ref] > Save/Clear > Save to 

Funkcja Skew dla 
przebiegu referencyjnego [Ref] > Skew, pokrętło wielofunkcyjne  

Funkcja Scale dla 
przebiegu referencyjnego [Ref] > Scale, pokrętło wielofunkcyjne  

Funkcja Offset dla 
przebiegu referencyjnego [Ref] > Offset, pokrętło wielofunkcyjne  

Kasowanie przebiegu 
referencyjnego 

[Ref] > Save/Clear > Clear 

[Save/Recall] > Default/Erase > Secure Erase 

Informacja o przebiegu 
referencyjnym 

[Ref] > Save/Clear > Display Info 

Włączenie 
przeźroczystego tła dla 
funkcji Info  

[Ref] > Save/Clear > Transparent 

Zapisanie lub wczytanie 
przebiegu referencyjnego 
z nośnika USB 

[Save/Recall] > Save > Format, Reference Waveform data (*.h5) 

[Save/Recall] > Recall > Recall:, Reference Waveform data (*.h5) 
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11 USTAWIENIA WYŚWIETLANIA 

Użytkownik może regulować m.in. intensywność wyświetlanego przebiegu 

analogowego tak ażeby możliwe było uwypuklenie różnych cech sygnału takich jak 

szybkozmienność przebiegu czy niski poziom wyzwalania.  

Przy włączonej poświacie oscyloskop odświeża przebieg danymi z kolejnej akwizycji, 

ale nie następuję natychmiastowe wymazanie wyników poprzedniego przebiegu. 

Wszystkie poprzednie przebiegi są wyświetlane z malejącą intensywnością. 

Nowe dane są prezentowane z normalną intensywnością i kolorem. 

Tabela 12 Funkcje dostępne dla ustawień wyświetlania przebiegów 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Intensywność przebiegu 
(dla wejść kanałów 
analogowych) 

[Intensity] i małe pokrętło poniżej pokrętła wielofunkcyjnego 

Zwiększenie intensywności wyświetlania pozwala na dostrzeżenie 

maksymalnego poziomu szumu, a także sporadycznych zdarzeń 

w mierzonym przebiegu. Zmniejszenie intensywności może z kolei 

wyeksponować więcej szczegółów w przypadku złożonych sygnałów. 

Nieskończona poświata [Display] > Persistance>Persistance, ∞Persistance 

Zmienna poświata [Display] > Persistance>Persistance, Variable Persistance, 

[Display] > Persistance > Time, pokrętło wielofunkcyjne  

Wykasowanie poświaty [Display] > Persistance > Clear Persistance 

Czyszczenie ekranu [Display] > Clear Display             

Do czyszczenia ekranu użytkownik może skonfigurować funkcję 
dostępną pod przyciskiem [Quick Action] 

Ustawienie intensywności 
świecenia siatki [Display] > Grid > Intensity, pokrętło wielofunkcyjne  

Typ wyświetlanej siatki [Display] > Grid > Grid (Full, mV, IRE) 

Etykiety przebiegów [Display] >  Labels > 

Kasowanie bibliotek 
etykiet 

[Utility] > Options > Preferences > Default Library 

Adnotacje [Display] >  Anotation > 

Zamrażanie 
zobrazowania 

Funkcja zamrażania zobrazowania jest dostępna po skonfigurowania 
przycisku [Quick Action]. 

Pamiętać należy o tym, że wiele funkcji czy czynności spowoduje 
„odmrożenie” zobrazowania np. regulacja poziomu wyzwalania, 
regulacja ustawień dla osi pionowej lub poziomej czy też zapisywanie 
danych. 
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12 WCZYTYWANIE ETYKIET Z 

UTWORZONEGO PLIKU TEKSTOWEGO 

 Bardzo pomocna dla użytkownika oscyloskopu może być możliwość 

utworzenia listy etykiet za pomocą zewnętrznego edytora tekstu, 

a następnie wczytanie takiej listy etykiet do oscyloskopu. Przy dużej 

liście etykiet operacja taka będzie szybsza i prostsza. 

Utworzona przez użytkownika lista może zawierać do 75 etykiet. 

Po załadowaniu listy, etykiety są dodawane do początku listy etykiet 

oscyloskopu. Jeśli w pliku znajduje się więcej niż 75 etykiet to 

załadowanych zostanie tylko pierwszych 75 etykiet. 

W celu wczytania do oscyloskopu etykiet z zewnętrznego pliku 

tekstowego należy: 

1. Za pomocą edytora tekstu utworzyć żądane etykiety. Każda etykieta 

może składać się maksymalnie z 10 znaków. Separacja 

poszczególnych etykiet odbywa się za pomocą przycisku Enter. 

2. Zmienić nazwę pliku zawierającego etykiety na labellist.txt 

i zapisać go na nośniku USB. 

3. Dołączyć nośnik do portu USB oscyloskopu i wczytać plik 

z etykietami za pomocą funkcji File Explorer. W tym celu należy 

nacisnąć przyciski: [Utility] > File Explorer. 

UWAGA 
Po naciśnięciu przycisku Library, wyświetlona zostanie lista ostatnich 
75 etykiet. Lista ta nie zawiera zduplikowanych etykiet. Etykiety mogą 
być zakończone dowolną liczbą cyfr. Tak długo, jak podstawowa nazwa 
etykiety jest taka sama jak w etykiecie istniejącej w bibliotece, nowa 
etykieta nie zostanie wprowadzona do biblioteki. Na przykład, jeśli 
w bibliotece znajduje się etykieta A0, to nowa etykieta o nazwie A12345 
nie zostanie dodana do biblioteki. 

Po zapisaniu nowej etykiety, zdefiniowanej przez użytkownika zastąpi 
ona najstarszą etykietę na liście. Najstarszą etykietą jest ta etykieta, dla 
której czas, jaki upłynął od jej przypisania do jakiegokolwiek kanału jest 
największy. Za każdym razem, kiedy etykieta jest przypisywana do 
dowolnego kanału staje się ona najnowszą etykietą. Tak więc, po użyciu 
wczytanych z listy etykiet będą one dominowały na liście, dzięki czemu 
łatwiej jest dostosować wygląd zobrazowania prezentowanego na 
ekranie instrumentu dla potrzeb użytkownika. 

Po przywróceniu fabrycznej listy etykiet, wszystkie niestandardowe 
etykiety zdefiniowane przez użytkownika zostaną usunięte. 
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13 WYZWALANIE 

Ustawienia sposobu wyzwalania oscyloskopu definiują, kiedy przyrząd powinien 

zbierać dane pomiarowe i kiedy powinien je wyświetlać na ekranie. Użytkownik może 

np. ustawić wyzwalanie za pomocą zbocza narastającego sygnału podawanego na 

wejście kanału analogowego nr 1. 

Jako źródło sygnału wyzwalającego może być wykorzystane dowolne wejście 

oscyloskopu lub wejście zewnętrznego sygnału wyzwalającego Ext Trig.  

Zmiany w ustawieniu wyzwalania są wprowadzane w przyrządzie natychmiast. Jeżeli 

oscyloskop nie dokonuje pomiaru podczas zmiany parametrów wyzwalania, to nowe 

ustawienia zostaną wprowadzone zaraz po naciśnięciu przycisku [Run/Stop] lub 

[Single]. Jeżeli podczas wprowadzania zmian przyrząd jest w trakcie akwizycji danych 

pomiarowych, to nowe ustawienia parametrów wyzwalania zaczną obowiązywać zaraz 

od początku nowej akwizycji danych.  

Możliwe jest zapisanie ustawień parametrów wyzwalania wraz z innymi ustawieniami 

konfiguracyjnymi oscyloskopu. 

13.1 Pokrętła i przyciski funkcji wyzwalania 

 

13.2 Rodzaje wyzwoleń 

Dodatkowo, poza ustawieniem wyzwalania za pomocą zbocza impulsu użytkownik 

może wybrać wyzwalanie szerokością impulsu czy też sygnałem video. W przyrządach 

serii 1000 X możliwe jest wykorzystanie wyzwalania za pomocą wzorca sygnału, 

odpowiedniego czasu narastania lub opadania zbocza oraz za pomocą 

zdefiniowanych i przechwyconych przez przyrząd przekroczeń poziomów.  
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Tabela 13 Parametry dostępne przy konfiguracji sposobu wyzwalania przyrządu 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Poziom wyzwalania Ustawienie poziomu wyzwalającego wykonać można za pomocą 

pokrętła regulacji poziomu wyzwalania lub ustawiając poziom za 

pomocą przycisków: 

[Analyze] > Features, Trigger Levels 

Poziom dla wyzwalania zboczem impulsu dla linii zasilania nie jest 

regulowany. W tym przypadku wyzwalanie jest zsynchronizowane 

z napięciem zasilającym oscyloskop. 

Typ wyzwalania [Trigger] > Trigger Type (Edge, Pulse Width, Video, Serial 1, Pattern*, 
Rise/Fall Time*, Setup and Hold*) 

Wyzwalanie zboczem [Auto Scale] (konfiguracja wyzwalania zboczem) 

[Trigger] > Trigger Type, Edge 

Wyzwalanie szerokością 
impulsu 

[Trigger] > Trigger Type, Pulse Width 

Wyzwalanie sygnałem 
video 

[Trigger] > Trigger Type, Video 

Informacja: Wiele sygnałów video jest generowanych przez źródła 

o impedancji wyjściowej 75. W celu zapewnienia właściwego 
dopasowania impedancyjnego, do wejścia sygnału wyzwalającego 
należy dołączyć odpowiednio dopasowane obciążenie (np. Keysight 
11094B). 

Wyzwalanie wzorcem [Trigger] > Trigger Type, Pattern 

Wyzwalanie czasem 
narastania lub opadania 

[Trigger] > Trigger Type, Rise/Fall Time 

Wyzwalanie za pomocą 
zdefiniowanych i 
przechwyconych 
przekroczeń poziomów 

[Trigger] > Trigger Type, Setup and Hold 

Wyzwalanie za pomocą 
magistrali szeregowej 

[Trigger] > Trigger Type, Serial1 

* Wyzwalanie wzorcem, czasem narastania i opadania oraz za pomocą zdefiniowanych 
i przechwyconych przekroczeń poziomów jest dostępne tylko dla przyrządów serii DSOX1000. 

13.3 Trigger Mode, Coupling, Reject, Holdoff 

Sygnały zaszumione Jeżeli obserwowany sygnał jest zaszumiony, to za pomocą właściwej 

konfiguracji oscyloskopu użytkownik może zredukować poziom szumu 

zarówno w ścieżce sygnału wyzwalającego jak i wyświetlanego 

przebiegu. W pierwszej kolejności konieczne jest ustabilizowanie 

wyświetlanego przebiegu poprzez usunięcie szumu ze ścieżki 

wyzwalania. Następnie należy zredukować szum w sygnale 

obserwowanym. W tym celu należy: 

1. Podłączyć źródło sygnału do oscyloskopu i uzyskać stabilne 

zobrazowanie. 
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2. Usunąć szum ze ścieżki sygnału wyzwalającego poprzez 

włączenie filtru górno zaporowego, dolno zaporowego lub 

włączenie funkcji eliminacji szumu. 

3. W celu wyeliminowania szumu w torze mierzonego sygnału 

należy zastosować się do zaleceń opisanych w rozdziale Wybór 

trybu akwizycji danych pomiarowych.  

Tabela 14 Parametry funkcji Trigger Mode, Coupling, Reject, Holdoff 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Tryb wyzwalania - Trigger 
mode 

[Trigger] > Mode  

W celu szybkiego przełączania się pomiędzy trybem wyzwalania Auto 

i Normal należy właściwie zdefiniować przycisk [Quick Action] 

Wyzwalanie 
automatyczne - Auto 
trigger mode 

[Trigger] > Mode, Auto  

W trybie wyzwalania Auto (ustawienie domyślne), jeżeli określone 

warunki wyzwolenia pomiaru nie nastąpią, wyzwalanie pomiarów 

zostanie wymuszone i zostanie przeprowadzona akwizycja danych 

pomiarowych, po czym na ekranie zostanie wyświetlony zmierzony 

przebieg. 

Stosowanie trybu wyzwalania Auto jest właściwe, gdy: 

• Sprawdzane będą sygnały typu DC albo sygnały o nieznanej 

aktywności i poziomach. 

• Jeżeli zdarzenia wyzwalające pojawiają się na tyle często, 

że wymuszenie wyzwalania nie będzie konieczne. 

Wyzwalanie w trybie 
Normal - Normal trigger 
mode 

[Trigger] > Mode, Normal  

Wyzwolenie pomiarów i rozpoczęcie akwizycji danych rozpocznie się 
tylko wtedy, gdy spełnione zostaną warunki wyzwolenia.  

Stosowanie trybu wyzwalania Normal jest właściwe, gdy: 

• Użytkownik chce uzyskać wyzwolenie pomiaru jedynie w przypadku 

wystąpienia zdarzenia określonego warunkami wyzwalania. 

• Do wykonywania pojedynczych zrzutów danych do pamięci po 

naciśnięciu przycisku [Single].  

Wykonywanie pomiarów trybie Single może wiązać się z koniecznością 
zainicjowania jakiejś określonej akcji w badanym urządzeniu. 
Użytkownik może nie chcieć, żeby nastąpiło automatyczne wymuszenie 
wyzwalania przed właściwym ustawieniem badanego urządzenia. 
Zatem przed rozpoczęciem konfiguracji badanego urządzenia należy 
zaczekać do wyświetlenia wskaźnika Trig’d? 

Wymuszenie wyzwolenia [Force] 

Przy wyzwalaniu w trybie Normal, jeżeli nie wystąpi sygnał wyzwolenia 
pomiarów, to użytkownik może wymusić rozpoczęcie pomiarów poprze 
naciśnięcie przycisku [Force] 

Sprzężenie wyzwalania 
(Trigger coupling) 

[Trigger] > Coupling (DC, AC, LF Reject, TV/Video) 

Uwaga: Funkcja sprzężenia wyzwalania jest niezależna od funkcji 
sprzężenia kanałów. 

Eliminowanie szumu z 
sygnału wyzwalania 
(Trigger noise reject) 

[Trigger] > Noise Rej 
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Eliminowanie wysokich 
częstotliwości z sygnału 
wyzwalania (Trigger high 
frequency reject) 

[Trigger] > HF Reject 

Trigger holdoff – blokada 
układu wyzwalania 

[Trigger] > Holdoff 

Prawidłowe ustawienie funkcji Holdoff oznacza włączenie układu blokady 

wyzwolenia pomiarów przez czas nieco krótszy niż okres mierzonego 

przebiegu.  
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14 WEJŚCIE ZEWNĘTRZNEGO SYGNAŁU 

WYZWALAJĄCEGO 

Wejście zewnętrznego sygnału wyzwalającego służy do wyzwalania pomiarów 

w oscyloskopie przez zewnętrze źródło sygnału. Wejście to oznaczone jest opisem 

EXT TRIG IN. 

UWAGA 
Maksymalna wartość napięcia, jakie może zostać podane na wejście 
EXT TRIG IN to 150 V RMS, 200 Vpk 

 

Impedancja wejściowa wejścia sygnału referencyjnego wynosi 1 MΩ. Pozwala ona na 

wykorzystywanie do realizacji pomiarów standardowych sond pasywnych. Wysoka 

impedancja wejściowa zapobiega efektowi dodatkowego obciążania badanego układu 

przez oscyloskop. 

Tabela 15 Parametry i funkcje portu wejściowego zewnętrznego sygnału wyzwalającego 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Jednostki dla 
zewnętrznego sygnału 
wyzwalającego 

[External] > Units (Volts, Amps)  

Tłumienie portu Ext Trig 
[External] > Probe, Ratio/Decibels, pokrętło wielofunkcyjne  

Próg dla portu Ext Trig 
[External] > Treshold, pokrętło wielofunkcyjne  

Zakres dla portu Ext Trig 
[External] > Range, pokrętło wielofunkcyjne  

Tylko dla przyrządów serii DSOX1000. W przyrządach EDUX1000 
zakres jest ustawiony na stałe na wartość 8 V dla sond ze 
współczynnikiem tłumienia 1:1. 

Wybór pozycji 
zewnętrznego przebiegu 
wyzwalającego 

[External] > Position, pokrętło wielofunkcyjne  
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15 STEROWANIE PROCESEM AKWIZYCJI 

DANYCH POMIAROWYCH 

W rozdziale tym zostaną przedstawione podstawowe informacje dotyczące sterowania 

procesem akwizycji danych pomiarowych. 

15.1 Wybór trybu akwizycji danych pomiarowych 

Przy wyborze trybu akwizycji danych pomiarowych należy pamiętać o tym, że 

standardowo przy małych ustawieniach skali czas/działkę próbki są dziesiątkowane.  

Ponieważ szybkość próbkowania sygnału jest większa niż wymagana do wypełnienia 

pamięci przyrządu, część zebranych próbek jest odrzucana, przez co zmniejsza się 

efektywna szybkość próbkowania i wydłuża się okres pomiędzy próbkami.  

I tak np.: zakładając, że przetwornik oscyloskopu posiada okres próbkowania równy 

1 ns (maksymalna szybkość próbkowania wynosi 1GSa/s), a przyrząd posiada pamięć 

1M, to jej zapełnienie nastąpi po 1 ms. Jeżeli jednak czas akwizycji wynosić będzie 

100 ms (10ms/działkę), to tylko 1 próbka na 100 zebranych zostanie umieszczona 

w pamięci.   

Tabela 16 Funkcje dostępne dla akwizycji danych pomiarowych 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Tryb akwizycji [Acquire] > Acq Mode 

Akwizycja w trybie 
Normal 

[Acquire] > Acq Mode, Normal 

Tryb wybierany przy ustawieniu wolniejszych przebiegów podstawy 
czasu, bez uśredniania, z normalnym odrzucaniem niepotrzebnych 
próbek. Trybu tego należy używać przy większości wykonywanych 
pomiarów. 

Akwizycja w trybie Peak 
Detect 

[Acquire] > Acq Mode, Peak Detect 

Tryb wybierany przy ustawieniu wolniejszych przebiegów podstawy 

czasu, gdzie może występować odrzucanie próbek. W trybie tym 

zapisywane są próbki posiadające największą i najmniejszą wartość 

w czasie trwania okresu akwizycji danych. Trybu tego należy używać do 

zobrazowania szybko narastających i opadających impulsów 

sporadycznie występujących w przebiegu. 

Akwizycja w trybie 
Averaging 

[Acquire] > Acq Mode, Averaging, [Acquire] > #Avgs 

Tryb możliwy do wybrania dla wszystkich ustawień przebiegów 

podstawy czasu. Do wyliczenia wartości średniej zmierzonego sygnału 

w danym punkcie brana jest określona liczba próbek. Tryb ten należy 

wykorzystywać do redukcji szumu i zwiększenia rozdzielczości 

sygnałów periodycznych bez poszerzenia pasma pomiarowego 

i pogorszenia dokładności określania czasu narastania impulsu.  



Oscyloskopy InfiniiVision serii 1000 X   Instrukcja użytkowania 

Strona | 44 

Akwizycja w trybie High 
resolution 

[Acquire] > Acq Mode, High resolution 

Tryb wybierany przy ustawieniu wolniejszych przebiegów podstawy 
czasu. Wszystkie próbki zebrane w czasie zbierania danych są 
uśredniane, a wyznaczona wartość średnia jest zapisywana. Tryb ten 
służy do eliminowania wpływu szumu. 

Tabela 17 Funkcje dotyczące segmentacji pamięci. Dostępne jedynie dla oscyloskopów serii 
DSOX1000 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Tryb akwizycji do 
posegmentowanej 
pamięci 

[Acquire] > Segmented > Segmented, #of Segs, [Run] lub [Single] 

Przy włączonej segmentacji pamięci, po zapełnieniu każdego segmentu 

pamięci, oscyloskop ponownie uzbraja się i jest gotowy do przyjęcia 

sygnału wyzwalającego po upływie około 8 µs.  

Należy jednak pamiętać, że jeśli np. skala dla osi poziomej jest 

ustawiona na 5 µs/działkę, a wskaźnik Time Reference jest ustawiony 

na Center, to ponowne uzbrojenie nastąpi po zapełnieniu wszystkich 

działek, co zajmie co najmniej 50 µs (przechwytywanych jest 25 µs jako 

dane pre-trigger i 25 µs jako dane post-trigger). 

Poruszanie się po 
segmentach pamięci 

[Acquire] > Segmented > Curent Seg 

Segmentacja pamięci i 
poświata 

[Display] > Persistance, Infinite ∞Persistance lub Variable 

Persistance 

[Acquire] > Segmented > Analyze Segments 

Zapisywanie segmentów 
pamięci na zewnętrzny 
nośnik USB 

[Save/Recall] > Save > Format (CSV, ASCII XY, BIN) > Settings > 
Save Seg (Current, All) 

15.2 Przegląd informacji dotyczących próbkowania 
mierzonego sygnału 

Ażeby możliwe było zrozumienie trybów próbkowania i akwizycji danych pomiarowych, 

jakie są wykorzystywane w oscyloskopie, pomocne jest zrozumienie twierdzenia 

o próbkowaniu, aliasingu, poznanie związków pomiędzy pasmem oscyloskopu 

i szybkością próbkowania, czasem narastania wymaganiami dotyczącymi pasma 

oscyloskopu, a także zasad dotyczących tego jak wielkość pamięci wpływa na 

szybkość próbkowania przyrządu. 

Twierdzenie 

o próbkowaniu 

Twierdzenie Nyquista dotyczące próbkowania mówi, że dla 

ograniczonego pasma o częstotliwości maksymalnej równej fMAX, możliwe 

jest dokonanie rekonstrukcji sygnału bez efektu aliasingu, za pomocą 

równomiernie rozłożonych próbek sygnału, przy czym częstotliwość 

próbkowania musi być co najmniej dwukrotnie większa niż górna 

częstotliwość pasma fMAX. 

Nyquist
S

MAX f
f

f 
2
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Aliasing Zjawisko aliasingu występuje w przypadku, gdy częstotliwość sygnału 

próbkującego jest mniejsza niż dwukrotna wartość największej 

próbkowanej częstotliwości. Jest to zakłócenie sygnału spowodowane 

przez niskoczęstotliwościowy sygnał fałszywie zrekonstruowany na 

podstawie niewystarczającej liczby próbek pomiarowych.  

 
Rys. nr 3 Powstawanie aliasingu 

Pasmo pracy 

oscyloskopu i szybkość 

próbkowania 

Pasmo pracy oscyloskopu typowo opisywane jest jako zakres 

częstotliwości od 0 Hz do fBW, gdzie fBW jest najniższą częstotliwością, 

przy której przebieg sygnału sinusoidalnego jest tłumiony o 3 dB. (daje 

w efekcie 30% błąd dla amplitudy).  

Ponieważ zgodnie z twierdzeniem o próbkowaniu częstotliwość 

próbkowania musi być co najmniej dwa razy większa niż maksymalna 

częstotliwość mierzonego sygnału, zatem: 

BWS ff  2  

Pamiętać jednak należy, że twierdzenie o próbkowaniu zakłada, 

że w sygnale nie występują składowe o częstotliwości większej niż 

częstotliwość maksymalna (w tym wypadku fBW), zatem wymagane jest, 

ażeby nie było odpowiedzi częstotliwościowej układu powyżej 

częstotliwości maksymalnej.  

 

Rys. nr 4 Teoretyczny przebieg sygnału odpowiedzi dla oscyloskopu 

Niestety sygnały cyfrowe posiadają składowe o częstotliwości większej 

niż częstotliwość podstawowa (np. przebieg prostokątny można 

T
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Czstotliwość
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przedstawić, jako sumę przebiegu sinusoidalnego o danej częstotliwości 

i nieskończenie dużej liczby parzystych harmonicznych), a ponadto 

oscyloskopy pracujące w paśmie do 500 MHz posiadają charakterystykę 

odpowiedzi zbliżoną do przebiegu Gaussa. 

 

Rys. nr 5 Szybkość próbkowania i pasmo pracy oscyloskopu 

W praktyce szybkość próbkowania oscyloskopu powinna być co najmniej 

czterokrotnie większa niż pasmo pracy oscyloskopu. Spowoduje to 

zmniejszenie efektu aliasingu, ponieważ składowe częstotliwości 

wpływające na powstawanie aliasingu będą znacznie bardziej tłumione.  

Więcej informacji na ten temat można znaleźć w nocie aplikacyjnej 

nr 1587: Evaluating Oscilloscope Sample Rates vs. Sampling Fidelity: 

How to Make the Most Accurate Digital Measurements, 

(http://literature.cdn.keysight.com/litweb/pdf/5989-5732EN.pdf). 

Czas narastania 

oscyloskopu 

Ściśle powiązany z pasmem pracy oscyloskopu jest czas narastania 

charakterystyczny dla oscyloskopu. Oscyloskopy o charakterystyce 

wejściowej zbliżonej do charakterystyki Gaussa posiadają czas 

narastania równy 0,35/fBW (określony na podstawie kryterium 10% i 90% 

poziomu sygnału). Czas narastania oscyloskopu nie określa 

najszybszego czasu narastania zbocza, jakie mogłoby zostać zmierzone 

przez przyrząd. Jest to czas narastania najszybszego zbocza, jakie 

mogłoby zostać przez oscyloskop wyprodukowane.  

Wymagania dotyczące 

pasma oscyloskopu 

Wymagania dotyczące szerokości pasma pozwalające oscyloskopowi na 

wykonywanie dokładnych pomiarów nie są głównie zdeterminowane 

przez częstotliwość mierzonego sygnału, ale przede wszystkim przez 

szybkość narastania zbocza mierzonego sygnału. W celu określenia 

wymaganego pasma pracy oscyloskopu należy: 

1. Określić, jakie najszybsze zbocza mają być mierzone przez 

oscyloskop. 

Szybkość narastania zbocza można określić na podstawie informacji 

podawanych w specyfikacjach urządzeń do badania, których 

oscyloskop będzie używany.  

2. Wyliczyć maksymalną wartość „praktycznego” komponentu 

częstotliwościowego. 

T
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Częstotliwość

Częstotliwości
będące przyczyną
powstawania błędów
aliasingu

Ograniczenie pasma oscyloskopu (f ) do 1/4 częstotliwości próbkowania (f  / 4) BW S

zmniejsza składowe częstotliwości powyżej częstotliwości Nyquista (f )N

http://literature.cdn.keysight.com/litweb/pdf/5989-5732EN.pdf
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Na podstawie dostępnej literatury np. Dr. Howard W. Johnson's book, 

High- Speed Digital Design – A Handbook of Black Magic, wszystkie 

szybkie zbocza impulsów posiadają nieskończone widmo. Można 

jednak stwierdzić, że jest pewien punkt przegięcia w dziedzinie 

częstotliwości dla szybko narastających zboczy, gdzie częstotliwości 

większe niż częstotliwość punktu przegięcia mają nieznaczny wpływ 

na kształt narastającego zbocza. Częstotliwość punktu przegięcia 

można wyznaczyć na podstawie poniższych zależności: 

90%)(10%narastania

5,0




t

fkr  

80%)(20%narastania

4,0




t

fkr  

gdzie: 

krf  - częstotliwość punktu przegięcia, powyżej której wpływ na 

kształt narastania zbocza jest nieznaczny 

90%)(10%narastania t  - czas narastania zbocza określony na podstawie 

kryterium przekroczenia 10% i 90% amplitudy zbocza 

80%)(20%narastania t  - czas narastania zbocza określony na podstawie 

kryterium przekroczenia 20% i 80% amplitudy zbocza 

3. Określić należy współczynnik korekcyjny związany z uzyskaniem 

odpowiedniej dokładności wpływającej na pasmo oscyloskopu. 

Wymagana dokładność Konieczna szerokość pasma oscyloskopu 

20% 
krBW ff  0,1  

10% 
krBW ff  3,1  

3% 
krBW ff  9,1  

 

Pamięć i szybkość 

próbkowania 

Liczba punktów w pamięci oscyloskopu jest ustalona, a maksymalna 

szybkość próbkowania związana jest z parametrami przetwornika 

analogowo-cyfrowego zastosowanego w oscyloskopie. Niemniej bieżąca 

szybkość próbkowania jest określona przez czas akwizycji (który jest 

zależny od ustawienia skali dla osi poziomej). 

Szybkość próbkowania = liczba próbek / czas akwizycji 

I tak, w celu zapisania sygnału o czasie trwania 50 µs w postaci zbioru 

50 000 próbek szybkość próbkowania musi wynosić 1 GSa/s. 

Jeżeli wydłużymy przedział czasu do 50 ms to przy takiej samej liczbie 

punktów (50 000) wymagana szybkość próbkowania będzie wynosić już 

tylko 1 MSa/s. 

Bieżąca szybkość próbkowania jest wyświetlana w obszarze 

informacyjnym po prawej stronie ekranu.  

Oscyloskop uzyskuje bieżącą wymaganą szybkość próbkowania poprzez 

odrzucenie (dziesiątkowanie) niepotrzebnych próbek. 
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16 KURSORY 

Kursory są niczym innym jak markerami, które można przesuwać wzdłuż osi X i Y, i za 

pomocą których można odczytywać wartości odpowiadające wskazanemu 

przebiegowi. Przy wykorzystaniu kursorów użytkownik może dokonać pomiarów 

napięcia, czasu, fazy lub różnych współczynników na sygnałach prezentowanych na 

ekranie oscyloskopu.  

Informacja dotycząca wskazań kursorów wyświetlana jest po prawej stronie obszaru 

informacyjnego. 

Kursor dla osi X Kursor dla osi X jest pionową przerywaną linią, którą można 

przemieszczać wzdłuż osi poziomej i można wykorzystywać do pomiarów 

czasu (s), częstotliwości (1/s), fazy (0) i współczynników (%). 

Przy wykorzystywaniu kursorów wraz z funkcją szybkiej transformaty 

Fouriera (FFT) kursory X będą wskazywały częstotliwość sygnału. 

W trybie XY kursory X prezentują wartość amplitud (napięcia lub prądu) 

zmierzonego za pomocą kanału nr 1. 

Kursory dla osi Y Kursor dla osi Y jest poziomą przerywaną linią, którą można 

przemieszczać wzdłuż osi pionowej i można wykorzystywać do pomiarów 

amplitudy napięcia lub prądu w zależności od ustawień jednostek (Probe 

Units) lub też do pomiarów współczynników (%). Jeżeli jako źródło 

wykorzystywany jest przebieg matematyczny to wskazywana wartość 

zależna jest od wybranej funkcji.  

Położenie kursorów Y można zmieniać wzdłuż osi Y i za ich pomocą 

można odczytywać wartość amplitudy przebiegu względem poziomu 

odniesienia z wyjątkiem przebiegu funkcji matematycznej z szybką 

transformatą Fouriera, kiedy to jest odczytywana wartość względem 

poziomu 0 dB.  

W trybie XY kursory Y prezentują wartość amplitud (napięcia lub prądu) 

zmierzonego za pomocą kanału nr 2. 
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16.1 Pokrętła i przyciski służące do sterowania 
położeniem kursorów 

 

Tabela 18 Funkcje dotyczące kursorów 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Wybranie trybu pracy 
kursorów 

[Cursors] > Mode 

Praca kursorów w trybie 
ręcznym 

[Cursors] > Mode, Manual oraz pokrętło sterowania kursorami 

Praca kursorów w trybie 
śledzenia przebiegu 

[Cursors] > Mode, Track Waveform 

Tryb pomiarowy dla 
kursorów 

[Measure] (kursory będą wskazywały wartości dla ostatnio dodanego 
przebiegu) 

Praca kursorów w trybie 
binarnym 

[Cursors] > Mode, Binary 

Praca kursorów w trybie 
Hexadecymalnym 

[Cursors] > Mode, Hex 

Wybór jednostki 
wskazywanej przez 
kursor osi X 

[Cursors] > Units > X Units (Seconds, Hz, Phase, Ratio) 

Wybór jednostki 
wskazywanej przez 
kursor osi Y 

[Cursors] > Units > Y Units (Base, Ratio) 

 

  



Oscyloskopy InfiniiVision serii 1000 X   Instrukcja użytkowania 

Strona | 50 

   

17 POMIARY 

Przycisk [Meas] umożliwia wykonywanie automatycznych pomiarów parametrów 

przebiegów. Niektóre z pomiarów mogą być wykonywane jedynie w kanałach 

analogowych. 

INFORMACJA 
Jeżeli część mierzonego przebiegu nie jest wyświetlana na ekranie lub 
nie jest wyświetlana w wystarczającej rozdzielczości pozwalającej na 
wykonanie wiarygodnych pomiarów (około 4% pełnej skali), to wyniki 
pomiarów będą prezentowały wartości niedokładne.  

 

 

Wyniki ostatnich pomiarów są wyświetlane w obszarze informacji o pomiarach 

znajdującym się po prawej stronie ekranu. 

Kursory uruchamiają się i prezentują informacje dotyczące ostatnio mierzonego 

przebiegu. 

UWAGA 
Przetwarzanie po zakończeniu akwizycji danych 

Po zakończeniu procesu akwizycji danych pomiarowych, poza zmianą 
parametrów wyświetlanych, użytkownik może również wykonać operacje 
matematyczne na zebranych danych pomiarowych. Funkcje 
matematyczne i zebrane dane pomiarowe będą przeliczone stosownie do 
posługiwania się funkcjami przesuwania i powiększania zobrazowania 
oraz włączania i wyłączania zobrazowania poszczególnych kanałów. 
Jeżeli zmienia się powiększenie zobrazowania sygnału przy 
wykorzystaniu pokrętła zmiany skali dla osi poziomej i pionowej, to 
wpływa to na rozdzielczość zobrazowania. Ponieważ zarówno pomiary 
jak i funkcje matematyczne są wykonywane na danych wyświetlanych, to 
zmienia się ich rozdzielczość i zmianie ulegają wyświetlane wyniki. 

 

 Dla przebiegów zmierzonych za pomocą kanałów analogowych 

oscyloskopu dostępne są wszystkie typy pomiarów. Dla przebiegów 

będących wynikiem operacji matematycznych na danych pomierzonych 

(za wyjątkiem FFT) dostępne są wszystkie typy pomiarów poza licznikiem 

(Counter). Dla przebiegów będących wynikiem funkcji FFT dostępna jest 

ograniczona liczba pomiarów. Do wykonania części pomiarów na 

przebiegu będącym wynikiem obliczeń funkcji FFT należy posłużyć się 

funkcjami kursorów. 

Tabela 19 Funkcje dotyczące pomiarów 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Tryb pomiaru [Meas] > Type: 

Zrzut wszystkich 
pomiarów 

[Meas] > Type: Snapshot All, Add Measurement 

Użytkownik może również skonfigurować przycisk [Quick Action] do 
wykonania zrzutu wszystkich okien wyskakujących (popap). 

Pomiary napięć [Meas] > Type: (Peak-Peak, Maximum, Minimum, Amplitude, Top, 
Base, Overshoot, Average, DC RMS, AC RMS), Add Measurement 
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Pomiary czasu [Meas] > Type: (Period, Frequency, Counter, + Width, – Width, Duty 
Cycle, Rise Time, Fall Time, Delay, Phase), Add Measurement 

Pomiary za pomocą licznika (Counter) są dostępne, jeżeli jako tryb 
wyzwalania pomiarów ustawione zostało wyzwalaniem zboczem lub 
szerokością impulsu oraz jeżeli źródło sygnału mierzonego jest również 
źródłem sygnału wyzwalającego.  

Pomiary z 
wykorzystaniem progów 

[Meas] > Settings > Threshold lub 

[Analyze] > Features, Measurement Thresholds 

Okno pomiarowe [Meas] > Settings > Meas Window (Auto Select, Main, Zoom)  

Czyszczenie wyników 
pomiarów 

[Meas] > Clear Meas 
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18 WYKONYWANIE POMIARÓW 

Z WYKORZYSTANIEM MASEK 

POMIAROWYCH 

Wykonywanie pomiarów z wykorzystaniem masek pomiarowych dostępne jest 

w oscyloskopach serii DSOX1000. 

Jednym ze sposobów do weryfikacji zgodności zmierzonych przebiegów z określoną 

liczbą parametrów jest wykorzystanie zdefiniowanych masek pomiarowych. Maska 

określa obszar na ekranie oscyloskopu, w którym zmierzony przebieg musi się 

mieścić, ażeby można było stwierdzić, że parametry przebiegu są zgodne 

z wymaganiami. Zgodność przebiegu ze zdefiniowaną maską jest badana punkt po 

punkcie na obszarze całego ekranu oscyloskopu. Testowanie przebiegów 

z wykorzystaniem masek odbywa się na wyświetlanych kanałach analogowych. 

Nie można wykonać testów dla kanałów, które nie są wyświetlane. 

Tabela 20 Funkcje dotyczące pomiarów z wykorzystaniem masek  

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Włączanie lub wyłączanie 
trybu pomiarów z 
wykorzystaniem masek 

[Analyze] > Features, pokrętło wielofunkcyjne  do wyboru maski 

Mask Test, poprzez naciśnięcie pokrętła włączyć lub wyłączyć test 

Statystyki dla pomiarów z 
wykorzystaniem masek 

[Analyze] > Statistics > 

Ustawienie warunku, do 
którego wykonywane 
będą pomiary z 
wykorzystaniem masek 

[Analyze] > Setup > Run Until (Forever, Minimum # of Tests, Minimum 
Time, Minimum Sigma) 

Ustawienie reakcji na 
wystąpienie błędu 

[Analyze] > Setup > On Error (Stop, Save, Print, Measure) 

Blokada źródła dla 
pomiarów z 
wykorzystaniem masek 

[Analyze] > Setup > Source Lock 

Automatyczne tworzenie 
masek 

[Analyze] > Automask > 

Czyszczenie masek [Analyze] > Clear Mask 

Zapisywanie lub 
wczytywanie plików 
zawierających maski na/z 
nośnika USB 

[Save/Recall] > Save > Format, Mask (*.msk)  

[Save/Recall] > Recall > Recall:, Mask (*.msk) 
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18.1 Tworzenie i edycja pliku maski 
 

 Plik maski zawiera następujące sekcje: 

• Identyfikator pliku maski. 

• Tytuł maski. 

• Opis obszarów zakazanych maski. 

• Informacje dotyczące ustawień konfiguracyjnych oscyloskopu. 

Identyfikator pliku maski 

(Mask File Identifier) 

Identyfikator pliku maski posiada następującą konstrukcję: 

MASK_FILE_548XX 

Tytuł maski (Mask Title) Tytuł maski jest ciągiem znaków ASCII. Przykładem tytułu maski może 

być zapis: autoMask CH1 OCT 03 09:40:26 2008 

Jeżeli tytuł maski zawiera słowo "autoMask" to krawędź maski jest 

zdefiniowana jako obszar dający wynik pozytywny dla testu. 

W przeciwnym razie zbocze maski określa obszar dający wynik 

negatywny dla testu. 

Obszary zakazane maski 

 
 

Maska może zawierać do 8 zdefiniowanych obszarów zakazanych. Mogą 

być one ponumerowane w zakresie od 1 do 8. Ich położenie w pliku .msk 

jest dowolne. Numerowanie obszarów odbywa się od góry do dołu oraz 

od strony lewej do prawej. 

Plik Automask zwiera dwa specjalne obszary: obszar "przyklejony" 

bezpośrednio do góry ekranu i obszar, który jest „przyklejony” do dołu 

ekranu. Obszar górny jest definiowany przez maksymalne wartości Y, od 

pierwszego do ostatniego punktu pomiarowego. Obszar dolny jest 

definiowany przez minimalne wartości Y, od pierwszego do ostatniego 

punktu pomiarowego. 

Obszar górny musi mieć najniższy numer w pliku. Obszar dolny musi mieć 

najwyższy numer w pliku. 

Obszar oznaczony numerem 1 znajduje się u góry ekranu od jego lewej 

strony. Wartości osi Y w obszarze nr 1 opisują punkty wzdłuż linii, która 

jest dolną krawędzią górnej części maski.  

Podobnie wartości osi Y w obszarze nr 2 opisują punkty wzdłuż linii 

kształtującej górną krawędź dolnej części maski. 
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Wartości zapisane w pliku .msk są wartościami znormalizowanymi. 

Normalizację opisują każdorazowo cztery parametry: 

• X1 

• ΔX 

• Y1 

• Y2 

Parametry te zapisane są w części pliku .msk zawierającej dane 

konfiguracyjne oscyloskopu. 

Wartości Y (zwykle są to wartości napięcia) są znormalizowane przy 

wykorzystaniu następującej zależności: 

 
Y

YY
Ynorm






1
 

gdzie: 

12 YYY   

W celu dokonania przeliczenia wartości znormalizowanej na wartość 

napięcia należy posłużyć się następującą zależnością: 

  1YYYY norm   

gdzie: 

12 YYY   

 

Do przeprowadzenia normalizacji wartości X (zwykle jest to czas) 

wykorzystano poniższą zależność: 

 
X

XX
X norm






1
 

W celu dokonania przeliczenia wartości znormalizowanej na wartość 

czasu należy posłużyć się następującą zależnością: 

  1XXXX norm   

Informacje dotyczące 

ustawień 

konfiguracyjnych 

oscyloskopu  

Słowa kluczowe „setup” i „end_setup” określają początek i koniec sekcji 

w pliku .msk, w której zawarto informacje dotyczące ustawień 

konfiguracyjnych przyrządu. Ustawienia te zawierają komendy 

wykorzystywane do zdalnego sterowania przyrządem po to, żeby po 

wczytaniu pliku zawierającego dane maski oscyloskop wprowadził 

właściwe ustawienia.  

W sekcji tej mogą znaleźć się wszelkie komendy zdalnego starowania 

zaimplementowane w oscyloskopie. 

W sekcji tej znajdują się m.in. parametry wykorzystywane 

do przetworzenia znormalizowanych wartości opisujących poszczególne 

punkty maski na wartości rzeczywiste dla osi Y i X. Przykład opisu takich 

parametrów przedstawiono poniżej: 

:MTES:SCAL:BIND 0  
:MTES:SCAL:X1 -400.000E-06  
:MTES:SCAL:XDEL +800.000E-06 
:MTES:SCAL:Y1 +359.000E-03  
:MTES:SCAL:Y2 +2.35900E+00 
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18.2 Budowanie pliku z danymi maski 

Na poniższym przykładzie przedstawiono wykorzystanie wszystkich ośmiu obszarów 

zakazanych do budowy pliku maski.  

 

 

Plik opisujący maskę widoczną powyżej przedstawia się następująco: 

 
MASK_FILE_548XX 

"All Regions" 

/* Region Number */ 1 

/* Number of vertices */ 4 

-12.50, MAX 

-10.00, 1.750 

10.00, 1.750 

12.50, MAX 

/* Region Number */ 2 

/* Number of vertices */ 5 

-10.00, 1.000 

-12.50, 0.500 

-15.00, 0.500 

-15.00, 1.500 

-12.50, 1.500 

/* Region Number */ 3 

/* Number of vertices */ 6 

-05.00, 1.000 

-02.50, 0.500 

02.50, 0.500 

05.00, 1.000 

02.50, 1.500 

-02.50, 1.500 

/* Region Number */ 4 

/* Number of vertices */ 5 

10.00, 1.000 

12.50, 0.500 

15.00, 0.500 

15.00, 1.500 

12.50, 1.500 

/* Region Number */ 5 

/* Number of vertices */ 5 

-10.00, -1.000 

-12.50, -0.500 

-15.00, -0.500 

-15.00, -1.500 

-12.50, -1.500 
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/* Region Number */ 6 

/* Number of vertices */ 6 

-05.00, -1.000 

-02.50, -0.500 

02.50, -0.500 

05.00, -1.000 

02.50, -1.500 

-02.50, -1.500 

/* Region Number */ 7 

/* Number of vertices */ 5 

10.00, -1.000 

12.50, -0.500 

15.00, -0.500 

15.00, -1.500 

12.50, -1.500 

/* Region Number */ 8 

/* Number of vertices */ 4 

-12.50, MIN 

-10.00, -1.750 

10.00, -1.750 

12.50, MIN 

 

setup  

:CHANnel1:RANGe +8.00E+00  

:CHANnel1:OFFSet +2.0E+00  

:CHANnel1:DISPlay 1  

:TIMebase:MODE MAIN  

:TIMebase:REFerence CENTer  

:TIMebase:RANGe +50.00E-09  

:TIMebase:POSition +10.0E-09  

:MTESt:SOURce CHANnel1  

:MTESt:ENABle 1  

:MTESt:LOCK 1  

:MTESt:SCALe:X1 +10.0E-09  

:MTESt:SCALe:XDELta +1.0000E-09  

:MTESt:SCALe:Y1 +2.0E+00  

:MTESt:SCALe:Y2 +4.00000E+00  

end_setup  

 W pliku maski wszystkie zdefiniowane regiony muszą być oddzielone od 

siebie pustą linią. 

Regiony maski są zdefiniowane przez wiele punktów określających 

wierzchołki maski (jak na wykresie prostokątnym za pomocą 

współrzędnych x,y). Wartość „y” „MAX” wskazuje górną część siatki, 

a wartość „y” „MIN” określa dolną część siatki. 

Zobrazowanie maski we współrzędnych x,y jest związane z siatką 

wyświetlaną na ekranie oscyloskopu za pomocą komendy 

konfiguracyjnej :MTESt:SCALe 

Siatka zobrazowania ma swój punkt referencyjny dla osi czasu (po lewej 

stronie, w środku lub po prawej stronie zobrazowania) oraz punkt 

wyzwalania (t=0) określony wartością czasu opóźnienia względem 

punktu referencyjnego. Na siatce znajduje się również punkt referencyjny 

dla amplitudy określający wartość 0V (z offsetem określanym względem 

środka siatki).  

Wartości konfiguracyjne X1 i Y1 umieszczają współrzędne x, y regionu 

maski względem tych dwóch punktów referencyjnych (dla t=0 i V=0) 

natomiast XDELTa i Y2 definiują wielkość regionu w jednostkach x i y. 
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• Polecenie konfiguracyjne X1 określa położenie regionu na osi 

czasu względem osi x 

• Polecenie konfiguracyjne Y1 określa położenie regionu na osi 

amplitudy względem osi y 

• Polecenie konfiguracyjne XDELta określa czas związany z każdą 

jednostką X 

• Polecenie konfiguracyjne Y2 określa położenie pionowe wartości 

y=1 na wykresie x,y (w efekcie Y2-Y1 jest to wartość YDELta) 

I tak np. za pomocą siatki, której położenie na osi czas jest 10 ns przed 

punktem referencyjnym (umieszczonym na środku ekranu) i poziomem 

odniesienia dla amplitudy 2 V poniżej środka ekranu, umiejscowienie 

regionu maski w środku ekranu wymaga ustawienia parametrów 

X1=10 ns, Y1=2 V. 

Jeżeli parametr XDELta jest ustawiony na wartość 5 ns a parametr Y2 na 

wartość 4 V. Maska regionu, której współrzędne wierzchołów wynoszą 

odpowiednio (-1,1), (1,1), (1,-1) i (-1,-1) obejmuje sobą obszar od 5 ns do 

15 ns na osi czasu i od 0 V do 4 V na osi amplitudy. 

Jeżeli użytkownik przesunie region maski do punktu t=0 i V=0 poprzez 

ustawienie wartości X1=0 i Y1=0, to wierzchołki definiujące region 

z punktu -5 ns przejdą na wartość 5 ns i z wartości -2 V przejdą na 

wartość 2 V. 

INFORMACJA 
Maska może składać się z maksymalnie 8 regionów, przy czym 
w dowolnej kolumnie pionowej możliwe jest zdefiniowanie maksymalnie 
4 regionów i jeden z regionów musi dochodzić do wartości maksymalnej 
(przy użyciu zmiennej MAX) oraz jeden z regionów musi być styczny 
z wartością minimalną (przy użyciu zmiennej MIN). 

 

W jaki sposób 

wykonywane są pomiary 

z wykorzystaniem maski 

Oscyloskopy InfiniiVision wykonują pomiary z wykorzystaniem maski 

w sposób następujący. W pierwszej kolejności tworzona macierz 

o wymiarach 200x640 dla obszaru wyświetlanego na ekranie 

oscyloskopu. Każda komórka macierzy jest oznaczona w zależności 

od tego czy leży w obszarze zakazanym czy dozwolonym. Za każdym 

razem, gdy punkt zmierzonego przebiegu znajdzie się w komórce 

należącej do obszaru zakazanego generowany jest sygnał błędu. Jeżeli 

wybrany został pomiar typu Test All, to każdy kanał analogowy jest 

sprawdzany na zgodność z maską dla każdej akwizycji. 

Dla pojedynczego kanału może zostać zarejestrowanych do 2 miliardów 

błędów. Każda przetestowana akwizycja danych jest zliczana 

i wyświetlana, jako „# of Tests”.  

Plik maski zapewnia uzyskanie większej rozdzielczości niż 200x640. 

Dzięki kwantyzacji danych możliwe jest zredukowanie danych maski przy 

jej wyświetlaniu na ekranie oscyloskopu. 
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19 CYFROWY MIERNIK NAPIĘCIA 

Oscyloskop dla każdego z kanałów analogowych może realizować funkcję 

3 cyfrowego miernika napięcia oraz 5 cyfrowego miernika częstotliwości. Pomiary 

napięcia odbywają się asynchronicznie względem systemu akwizycji danych 

pomiarowych oscyloskopu i są zawsze dostępne. 

Tabela 21 Funkcje cyfrowego miernika napięcia 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Włączanie lub wyłączanie 
cyfrowego miernika 
napięcia 

[Analyze] > Features, pokrętło wielofunkcyjne  do wyboru funkcji 

Digital Voltmeter, poprzez naciśnięcie pokrętła włączyć lub wyłączyć 

funkcję miernika 

Ustawienie trybu pracy 
cyfrowego miernika 
napięcia 

[Analyze] > Mode (AC RMS, DC, DC RMS, Frequency) 

Praca w trybie miernika częstotliwości wymaga wyzwalania za pomocą 
zbocza impulsu lub szerokością impulsu oraz tego, aby źródło 
wyzwalania i źródło sygnału wyzwalającego były tym samym kanałem 
analogowym. 

Włączenie lub wyłączenie 
funkcji automatycznej 
regulacji zakresu 

[Analyze] > Auto Range  

Funkcja automatycznej regulacji zakresu może być wykorzystywana 
jeżeli kanał wejściowy dla którego włączony jest cyfrowy miernik 
napięcia nie jest wykorzystywany do wyzwalania oscyloskopu. 
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20 ANALIZA ODPOWIEDZI 

CZĘSTOTLIWOŚCIOWEJ PRZYRZĄDU 

W modelach oscyloskopów serii G (oscyloskopy posiadające wbudowany generator 

przebiegów), do sterowania pracą wewnętrznego generatora wykorzystywana jest 

funkcja analizy częstotliwości (Frequency Response Analysis). Przy każdej 

częstotliwości mierzy się wzmocnienie (A) i fazę, a wyniki prezentowane są na 

wykresie w funkcji częstotliwości. 

Po zakończeniu analizy odpowiedzi można, przesuwając marker na wykresie, 

odczytać zmierzone wartości wzmocnienia i fazy dla każdego punktu 

częstotliwościowego dla którego wykonywana była analiza. Można również 

dostosować skalę i przesunięcie wykresu w celu lepszego zobrazowania przebiegów 

wzmocnienia i fazy. 

Tabela 22 Funkcje analizy odpowiedzi częstotliwościowej 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe 
służące do jej wywołania 

Włączenie\wyłączenie analizy 
odpowiedzi częstotliwościowej 
Frequency Response Analysis 
(FRA) 

[Anayze] > Feature, pokrętłem wielofunkcyjnym  wybrać 
Frequency Response Analysis i zatwierdzić wybór naciskając 
pokrętło 

Wybór kanału za pomocą 
którego następuje 
próbkowanie napięcia i 
wyprowadzane jest ono na 
zewnątrz przyrządu 

[Analyze] > Setup > Input V 

[Analyze] > Setup > Output V 

Określenie minimalnej i 
maksymalnej częstotliwości 
przemiatania 

[Analyze] > Setup > Min/Max Freq, pokrętło wielofunkcyjne   

Ustawienie poziomu amplitudy 
dla generatora przebiegu i 
oczekiwanego obciążenia 
wyjściowego 

[Analyze] > Setup > Amplitude, pokrętło wielofunkcyjne  

[Analyze] > Setup > Output Load (50, Hugh-Z) 

Uruchomienie analizy [Analyze] > Run Analysis 

Regulacja skali i offsetu [Analyze] > Chart > Gain/Phase Scale/Offset, pokrętło 

wielofunkcyjne  

Wzmocnienie dla autoskali i 
wykresu fazy 

[Analyze] > Chart > Autoscale 

Obserwacja zmierzonego 
zysku i wartości fazy [Analyze] > Move Marker, pokrętło wielofunkcyjne  

Zapisanie danych na 
zewnętrznym nośniku pamięci 
dołączonym do portu USB 

[Save/Recall] > Save > Format, Frequency Response Analysis 
data (*.csv) 

  



Oscyloskopy InfiniiVision serii 1000 X   Instrukcja użytkowania 

Strona | 60 

   

21 GENERATOR PRZEBIEGÓW 

FUNKCYJNYCH 

W modelach oscyloskopów serii G wbudowany jest generator przebiegów. Pozwala 

on użytkownikowi na uzyskanie w szybki i prosty sposób różnego typu sygnałów 

wejściowych służących do testowania obwodów z wykorzystaniem oscyloskopu. 

Ustawienia generatora przebiegów mogą być zapisywane i przywoływane wraz 

z innymi ustawieniami oscyloskopu. 

Tabela 23 Funkcje generatora przebiegów 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Włączanie lub wyłączanie 
generatora przebiegów 

[Wave Gen] > Waveform (Sine, Square, Ramp, Pulse, DC, Noise)  

Ustawienie oczekiwanego 
obciążenia wyjścia 
generatora 

[Wave Gen] > Settings > Output Settings > Output Load (50, High-
Z) 

Ustawienie generatora 
przebiegów jako źródła 
sygnału synchronizacji 

[Wave Gen] > Settings > Output Settings > Trig Out, Waveform 
Generator Sync Pulse 

Dla wszystkich przebiegów za wyjątkiem napięcia stałego i szumu, 
sygnałem synchronizacji jest impuls dodatni (rozpoczynający się 
w chwili, gdy napięcie przekracza poziom 0 V) w standardzie TTL 
(lub przesunięty o wartość offsetu). 

Wybór jednego z 
predefiniowanych w 
generatorze poziomów 
logicznych  

[Wave Gen] > Settings > Logic Presets > (TTL, CMOS 5.0V, CMOS 
3.3V, CMOS 2.5V, ECL) 

Dodanie przebiegu 
szumowego do sygnału 
na wyjściu 

[Wave Gen] > Settings > Add Noise 

Włączenie lub wyłączenie 
modulacji 

[Wave Gen] > Settings > Modulation > Modulation 

Włączenie sygnału z 
modulacją AM na wyjściu 
generatora 

[Wave Gen] > Settings > Modulation > Type, Amplitude 
Modulation (AM) 

Włączenie sygnału z 
modulacją FM na wyjściu 
generatora 

[Wave Gen] > Settings > Modulation > Type, Frequency 
Modulation (FM) 

Włączenie sygnału z 
modulacją FSK na 
wyjściu generatora 

[Wave Gen] >Settings > Modulation > Type, Frequency-Shift 
Keying Modulation (FSK) 

Przywrócenie ustawień 
domyślnych generatora 

[Wave Gen] > Settings > Default Wave Gen 
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22 DEKODOWANIE TRANSMISJI 

SZEREGOWYCH 

W zależności od modelu oscyloskopu użytkownik ma dostęp do wsparcia sprzętowego 

dekodowania różnego typu transmisji szeregowych: 

Dekodowanie i wyzwalanie dla transmisji 
szeregowej  

Dostępne w modelu Z licencją 

CAN (Controller Area Network) Modele serii DSOX1000 AUTO 

I2C (Inter-IC) Wszystkie oscyloskopy 1000 X EMBD 

LIN (Local Interconnect Network) Modele serii DSOX1000 AUTO 

SPI (Serial Peripheral Interface) Modele serii DSOX1000 EMBD 

Protokół UART (Universal Asynchronous 
Receiver/Transmitter) włączając w to protokół 
rs232 (Standard rekomendowany) 

Wszystkie oscyloskopy 1000 X EMBD 

 

W celu szybkiego sprawdzenia jakiego typu licencje dostępne są w oscyloskopie 

należy nacisnąć przyciski [Help] > About Oscilloscope. 

Zamówienie licencji możliwe jest bezpośrednio u przedstawiciela firmy Keysight lub 

poprzez stronę internetową producenta pod adresem: www.keysight.com. 

Wyzwalanie dla 

transmisji szeregowych 

W niektórych przypadkach podobnie jak przy wyzwalaniu wolnych 

sygnałów transmisji szeregowej (dla standardu I2C, SPI, CAN, LIN itp.) 

może okazać się niezbędne przełączenie z trybu wyzwalania 

automatycznego i przejście w tryb wyzwalania Normal w celu 

ustabilizowania zobrazowania. Użytkownik może dokonać wyboru trybu 

wyzwalania poprzez naciśnięcie przycisku [Trigger] i przycisku 

kontekstowego Mode.  

Również poziom progu logicznego musi zostać odpowiednio dobrany 

dla każdego ze źródeł sygnału. Próg logiczny może być konfigurowany 

dla każdego sygnału szeregowego za pomocą opcji dostępnych w menu 

Signals dostępnym po naciśnięciu przycisku [Bus] i przycisku 

kontekstowego Signals. 

Tabela 24 Funkcje dekodowania i wyzwalania dla transmisji szeregowych 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Włączenie lub wyłączenie 
wybierania transmisji 
szeregowej 

[Bus] > Select, pokrętło wielofunkcyjne  do wyboru funkcji Serial 

Bus, poprzez naciśnięcie pokrętła włączyć lub wyłączyć funkcję 

Ustawienie trybu pracy 
dla transmisji szeregowej [Bus] > Mode pokrętło wielofunkcyjne  do wyboru typu transmisji 

(CAN*, I2C, LIN*, SPI*, UART/RS232) 

http://www.keysight.com/
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Wbudowana pomoc kontekstowa zawiera informacje o dekodowanych 
przebiegach. 

Wyzwalanie dla magistrali 
szeregowej  

[Trigger] > Trigger Type, Serial 1 

* Transmisja standardu CAN, LIN i SPI dostępna jest w modelach DSOX1000 

22.1 Transmisja CAN – dekodowanie/wyzwalanie 

W modelach DSOX1000 opcja wyzwalania i dekodowania transmisji w standardzie 

CAN może być włączona przy posiadaniu licencji AUTO. 

Przed rozpoczęciem wykorzystywania powyższej funkcji należy zapoznać się 

z pomocą kontekstową wbudowaną w oscyloskopie.  

Tabela 25 Funkcje dekodowania i wyzwalania dla transmisji w standardzie CAN 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Konfigurowanie sygnału 
CAN 

Po wyborze transmisji szeregowej oraz po wybraniu transmisji typu CAN 

należy nacisnąć przycisk [Bus] > Signals w celu wywołania menu 

transmisji w standardzie CAN. W tym menu użytkownik może wybrać 

kanał źródłowy, za pomocą którego będzie próbkowany sygnał oraz 

właściwy poziom progowy napięcia wykorzystywany podczas 

dekodowania lub wyzwalania a także inne parametry sygnału 

wejściowego. 

Szybkość bitowa 
transmisji CAN [Bus] > Signals > Baud, pokrętło wielofunkcyjne  

Punkt przykładowy dla 
transmisji CAN [Bus] > Signals > Sample Point, pokrętło wielofunkcyjne   

Typ i polaryzacja sygnału 
dla transmisji CAN [Bus] > Signals > Signal, pokrętło wielofunkcyjne  do wyboru (Rx, 

Tx, CAN_H, CAN_L, Differential (L-H), Differential (H-L)) 

Liczniki dla transmisji 
CAN 

[Bus] > Reset CAN Counters 

Liczniki są uruchomione nawet wtedy, gdy oscyloskop został 
zatrzymany (nie zbiera danych pomiarowych). 

W przypadku wystąpienia przepełnienia liczników wyświetlony zostanie 
komunikat OVERFLOW. 

Wyzwalanie transmisją w 
standardzie CAN 

[Trigger] > Trigger Type, Serial 1 (CAN) 

[Trigger] > Trigger on: (SOF - Start of Frame, Remote Frame ID (RTR), 

Data Frame ID (~RTR), Remote or Data Frame ID, Data Frame ID and 

Data, Error Frame, All Errors, Acknowledge Error, Overload Frame) 

Przy wyzwalaniu, gdzie możliwe jest zdefiniowanie ID bramki lub 

wartości przesyłanych danych, należy nacisnąć przycisk [Trigger] > 

Bits w celu wywołania menu, w którym można wprowadzić te dane. 
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22.2 Transmisja I2C – dekodowanie/wyzwalanie 

We wszystkich modelach oscyloskopów serii 1000 X dekodowanie i wyzwalanie 

za pomocą transmisji szeregowej w standardzie I2C może być aktywowane 

za pomocą licencji EMBD.  

Przed rozpoczęciem wykorzystywania powyższej funkcji należy zapoznać się 

z pomocą kontekstową wbudowaną w oscyloskopie.  

Tabela 26 Funkcje dekodowania i wyzwalania dla transmisji w standardzie I2C 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Konfigurowanie sygnału 
I2C 

Po wyborze transmisji szeregowej oraz po wybraniu transmisji 

w standardzie I2C należy nacisnąć przycisk [Bus] > Signals w celu 

wywołania menu transmisji I2C. W tym menu użytkownik może wybrać 

kanał źródłowy, za pomocą którego będą próbkowane sygnały zegara 

i danych. Użytkownik może również ustawić właściwy poziom progowy 

napięcia wykorzystywany podczas dekodowania lub wyzwalania. 

Ustawienie wielkości 
adresu dla transmisji I2C 

[Bus] > Addr Size (7Bit, 8 Bit) 

Wyzwalanie za pomocą 
transmisji I2C 

[Trigger] > Trigger Type, Serial 1 (I2C) 

[Trigger] > Trigger on: (Start Condition, Stop Condition, Missing 
Acknowledge, Address with no Ack, Restart, EEPROM Data Read, 
Frame (Start: Addr7: Read: Ack: Data), Frame (Start: Addr7: Write: Ack: 
Data), Frame (Start: Addr7: Read: Ack: Data: Ack: Data2), Frame (Start: 
Addr7: Write: Ack: Data: Ack: Data2), 10-bit Write) 

W przypadku, gdy użytkownik może określić adres lub wartość 
transmitowanej danej dostępne są dodatkowe przyciski kontekstowe, 
które mogą zostać użyte do wprowadzenia wartości.  

22.3 Transmisja LIN – dekodowanie/wyzwalanie 

W modelach DSOX1000 opcja wyzwalania i dekodowania transmisji w standardzie LIN 

może być włączona przy posiadaniu licencji AUTO. 

Przed rozpoczęciem wykorzystywania powyższej funkcji należy zapoznać się 

z pomocą kontekstową wbudowaną w oscyloskopie.  

Tabela 27 Funkcje dekodowania i wyzwalania dla transmisji w standardzie CAN 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Konfigurowanie sygnału 
LIN 

Po wyborze transmisji szeregowej oraz po wybraniu transmisji 

w standardzie LIN należy nacisnąć przycisk [Bus] > Signals w celu 

wywołania menu transmisji LIN. W menu tym użytkownik może wybrać 

kanał źródłowy, za pomocą którego będzie próbkowany sygnał oraz 

właściwy poziom progowy napięcia wykorzystywany podczas 

dekodowania lub wyzwalania, a także inne parametry sygnału 

wejściowego. 
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Szybkość bitowa 
transmisji LIN [Bus] > Signals > Baud > Baud, pokrętło wielofunkcyjne  

Punkt przykładowy dla 
transmisji CAN [Bus] > Signals > Sample Point, pokrętło wielofunkcyjne   

Typ i polaryzacja sygnału 
dla transmisji CAN [Bus] > Signals > Standard, pokrętło wielofunkcyjne  do wyboru 

(LIN 1.3, LIN 2.X) 

Konfigurowanie LIN synk 
break [Bus] > Signals Sync Break, pokrętło wielofunkcyjne  do (>=11, 

>=12, >=13) 

Wskazywanie polaryzacji 
sygnału LIN 

[Bus] > Show Polarity 

Wyzwalanie transmisją w 
standardzie LIN 

[Trigger] > Trigger Type, Serial 1 (LIN) 

[Trigger] > Trigger on: (Sync - Sync Break, ID - FrameID, ID & Data - 

FrameID and Data, Parity Error, Checksum Error) 

Przy wyzwalaniu, gdzie możliwe jest zdefiniowanie ID bramki lub 

wartości przesyłanych danych, wyświetlone zostaną dodatkowe 

przyciski kontekstowe, które służą do wprowadzenia powyższych 

danych.  

22.4 Transmisja SPI – dekodowanie/wyzwalanie 

W modelach DSOX1000 opcja wyzwalania i dekodowania transmisji w standardzie SPI 

może być włączona przy posiadaniu licencji EMBD. 

Przed rozpoczęciem wykorzystywania powyższej funkcji należy zapoznać się 

z pomocą kontekstową wbudowaną w oscyloskopie.  

Tabela 28 Funkcje dekodowania i wyzwalania dla transmisji w standardzie SPI 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Konfigurowanie sygnału 
SPI 

Po wyborze transmisji szeregowej oraz po wybraniu transmisji 

w standardzie SPI należy nacisnąć przycisk [Bus] > Signals w celu 

wywołania menu transmisji SPI. W menu dostępne są odrębne 

submenu i przyciski kontekstowe pozwalające na określenie 

parametrów takich jak Clock, MOSI/MISO i CS (wybór chipa), a także 

może wybrać kanał źródłowy, za pomocą którego będzie próbkowany 

sygnał oraz właściwy poziom progowy napięcia wykorzystywany 

podczas dekodowania lub wyzwalania, a także inne parametry sygnału 

wejściowego. 

UWAGA: Oscyloskop dwukanałowy model DSOX1000 wspiera 

trójprzewodową transmisję SPI. Ustawienia MOSI i MISO sygnałów 

wymuszane są jako takie same. Użytkownik może jednak wybrać jedno 

z nich. 

Za pomocą przycisku Display Info użytkownik może wyświetlić lub ukryć 

informacje dotyczące konfiguracji sygnałów i parametrów czasowych. 
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Bramkowanie SPI 
[Bus] > Signals > CS > Frame by, pokrętło wielofunkcyjne , (~CS 
- Not Chip Select, CS - Chip Select, Clock Timeout) 

Wielkość słowa SPI [Bus] > Word Size 

Kolejność bitów w SPI [Bus] > Bit Order (MSB, LSB) 

Wyzwalanie SPI [Trigger] > Trigger Type, Serial 1 (SPI)  

[Trigger] > Trigger Setup > Trigger Type (Master-Out, Slave-In 

(MOSI) Data) 

Dodatkowe przyciski kontekstowe pozwalają użytkownikowi na 

określenie liczby bitów danych i wartości dla każdego bitu. 

22.5 Transmisja UART/RS232 – dekodowanie/wyzwalanie 

Dla wszystkich oscyloskopów serii 1000 X dostępna jest opcja wyzwalania 

i dekodowania transmisji w standardzie UART/RS232, która może być włączona za 

pomocą licencji EMBD. 

Przed rozpoczęciem wykorzystywania powyższej funkcji należy zapoznać się 

z pomocą kontekstową wbudowaną w oscyloskopie.  

Tabela 29 Funkcje dekodowania i wyzwalania dla transmisji w standardzie UART/RS232 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Konfigurowanie sygnału 
UART/RS232 

Po wyborze transmisji szeregowej oraz po wybraniu transmisji 

w standardzie UART/RS232 należy nacisnąć przycisk [Bus] > Signals 

w celu wywołania menu dla sygnałów transmisji UART/RS232. W menu 

można wybrać kanały źródłowe, za pomocą których próbkowane będą 

sygnały RX i TX oraz właściwy poziom progowy napięcia dla każdego 

z kanałów.  

Konfigurowanie szyny 
danych UART/RS232 

Po wyborze transmisji szeregowej oraz po wybraniu transmisji 
w standardzie UART/RS232 należy nacisnąć przycisk [Bus] > Bus 
Config w celu wywołania menu konfiguracji szyny UART. 

Liczba bitów dla transmisji 
UART/RS232 [Bus] > Bus Config > #Bits, pokrętło wielofunkcyjne , (5, 6, 7, 8, 

9) 

Parzystość dla transmisji 
UART/RS232 [Bus] > Bus Config > Parity, pokrętło wielofunkcyjne  (Even, Odd, 

None) 

Szybkość bitowa 
transmisji UART/RS232 [Bus] > Bus Config > Baud Rate > Baud, pokrętło wielofunkcyjne  

Polaryzacja dla transmisji 
UART/RS232 [Bus] > Bus Config > Polarity, pokrętło wielofunkcyjne  do wyboru 

(Idle low, Idle high) 

Kolejność bitów dla 
transmisji UART/RS232 

[Bus] > Bus Config > Bit Order (LSB, MSB) 
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Baza wyświetlania dla 
transmisji UART/RS232 [Bus] > Settings > Base, pokrętło wielofunkcyjne  do wyboru (Hex, 

Binary, ASCII) 

Bramkowanie dla 
transmisji UART/RS232 [Bus] > Settings > Framing, pokrętło wielofunkcyjne  do wyboru 

(Off, 8 bit hex value) 

Liczniki dla transmisji 
UART/RS232 

[Bus] > Reset UART Counters 

Liczniki są uruchomione nawet wtedy, gdy oscyloskop został 
zatrzymany (nie zbiera danych pomiarowych). 

W przypadku wystąpienia przepełnienia liczników wyświetlony zostanie 
komunikat OVERFLOW. 

Wyzwalanie 
UART/RS232 

[Trigger] > Trigger Type, Serial 1 (SPI)  

[Trigger] > Trigger Setup > Trigger (Rx Start Bit, Rx Stop Bit, Rx Data, 

Rx 1:Data, Rx 0:Data, Rx X:Data, Tx Start Bit, Tx Stop Bit, Tx Data, Tx 

1:Data, Tx 0:Data, Tx X:Data, Rx or Tx Parity Error) 

W przypadku warunków wyzwalania, dla których można określić 

wartości danych, dostępne są dodatkowe klawisze kontekstowe służące 

do określania operatora porównania danych, wartości danych, podstawy 

wartości danych (Hex lub ASCII) oraz liczby n dla serii ramek. 
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23 ZAPISYWANIE USTAWIEŃ, ZRZUTÓW 

EKRANU LUB DANYCH 
 

Użytkownik ma możliwość zapisania w pamięci oscyloskopu lub na zewnętrznej 

pamięci dołączanej do portu USB danych konfiguracyjnych przyrządu do wykonywania 

różnego typu pomiarów, przebiegów referencyjnych oraz masek. Zapisane dane mogą 

zostać w dowolnej chwili wczytane do przyrządu.  

Możliwe jest również zapisywanie zrzutów ekranu zawierających zmierzone przebiegi. 

Zrzuty mogą być zapisane w formacie BMP lub PNG bezpośrednio na nośniku pamięci 

dołączonym do portu USB.  

W podobny sposób można zapisywać zebrane dane pomiarowe w postaci plików CSV, 

ASCII XY lub w formacie binarnym (BIN). 

W celu zabezpieczenia danych w przyrządzie zaimplementowana została komenda 

pozwalająca na bezpieczne usunięcie wszystkich danych zapisanych w nieulotnej 

pamięci przyrządu.  

Tabela 30 Funkcje dotyczące zapisywania i wczytywania danych z pamięci przyrządu 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Zapisywanie danych 
konfiguracyjnych, zrzutów 
ekranów, danych 
przebiegów i danych 
masek pomiarowych  

[Save/Recall] > Save > 

Użytkownik może również skonfigurować funkcje przycisku [Quick 

Action] do realizacji zapisu danych konfiguracyjnych, zrzutów ekranu 

lub danych pomiarowych.  

Zapisywanie plików 
konfiguracyjnych 

[Save/Recall] > Save > Format, Setup (*.scp) 

Nacisnąć w celu zapisania (Press to Save) 

Zapisywanie zrzutów 
ekranu  

[Save/Recall] > Save > Format,  

• 8-bit Bitmap image (*.bmp) 

• 24-bit Bitmap image (*.bmp) 

• 24 bit image (*.png) 

Settings > 

• Setup Info 

• Invert Grat 

• Pallete (Color, Grayscale) 

Zapisywanie danych 
przebiegów  

[Save/Recall] > Save > Format,  

• CSV data (*.csv) 

• ASCII XY data (*.csv) 

• Multi Channel Waveform data (*.h5) 

• Binary data (*.bin) 

Settings > Length (w celu wybrania liczby punktów pomiarowych, 

których dane zostaną zapisane)  
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Podczas zapisywania danych przebiegów pomiarowych, czas zapisu 

zależny jest wybranego format zapisu danych. Generalnie zapisywanie 

danych w formacie BIN jest znacznie szybsze niż zapisywanie danych 

w formacie ASCII XY czy zapisywanie w formacie wymagającym 

najwięcej czasu do zapisu jakim jest format CSV. 

Szybkie zapisywanie na 
zewnętrznym nośniku 
pamięci dołączonym do 
portu USB 

[Save to USB]  

Konfiguracja sposobu zapisywania danych za pomocą przycisku [Save 
to USB] wykonywana jest przy konfiguracji zapisu poprzez wybranie 
przycisków [Save/Recall] > Save 

Wczytywanie zapisanych 
plików konfiguracyjnych, 
masek lub przebiegów 
referencyjnych  

[Save/Recall] > Recall > Recall: 

Wczytywanie plików 
konfiguracyjnych 

[Save/Recall] > Recall > Recall:, Setup (*.scp) 

Wczytywanie ustawień 
fabrycznych przyrządu 

[Save/Recall] > Default/Erase > Factory Dafault 

Bezpieczne kasowanie 
zapisanych danych  

[Save/Recall] > Default/Erase > Secure Erase 

23.1 Kontrola liczności – parametr Length 

Kontrola liczności jest dostępna przy zapisie plików danych w formatach CSV, ASCII 

XY lub BIN. Umożliwia ona określenie liczba punktów zawierających informacje 

o zmierzonych parametrach zapisywanych do pliku.  

Maksymalna liczba punktów zapisywana w pliku danych zależna jest od trzech rzeczy: 

• Czy wykonywana jest akwizycja danych? Po zatrzymaniu procesu akwizycji, 

dane pochodzą z surowego rejestru akwizycji. Tymczasem podczas pracy 

przyrządu dane pobierane są z najświeższych zapisów pomiarów. 

• Czy zatrzymanie procesu akwizycji nastąpiło za pomocą przycisku [Stop] czy 

też po zakończeniu pojedynczego przebiegu wymuszonego naciśnięciem 

przycisku [Single]? Podczas akwizycji w trybie ciągłym, w celu zapewnienia 

możliwości rejestracji szybkich zmian poziomów sygnałów, dostępna pamięć 

przyrządu dzielona jest na dwa segmenty. Natomiast jeżeli uruchomiony został 

pojedynczy pomiar, to wykorzystywana jest całkowita pamięć przyrządu.  

• Czy włączony jest tylko jeden kanał z pary kanałów (kanał 1 i 2 to para kanałów). 

W przypadku pracy dwóch kanałów pamięć przyrządu rozdzielona jest na oba 

kanały.  

• Czy włączone są przebiegi referencyjne? Wyświetlanie przebiegów 

referencyjnych powoduje zajęcie części pamięci akwizycji. 

• Czy włączono segmentację pamięci (dostępne jedynie w modelach serii 

DSOX1000)? Pamięć akwizycji zostanie podzielona na segmenty. 
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• Jakie jest ustawienie skali poziomej określającej przypadającą długość odcinka 

czasu na podziałkę? Przy szybszych ustawieniach na zobrazowaniu pojawia się 

mniej punktów pomiarowych. 

• Przy zapisywaniu pliku w formacie CSV występuje ograniczenie maksymalnej 

liczby punktów danych zapisywanych w pliku do 50 000. 

Jeżeli jest to konieczne, sterowanie długością spowoduje eliminację pewnej liczby 

danych „1 z n”. Zatem jeżeli parametr Length zostanie ustawiony na wartość 1 000 

a na zobrazowaniu prezentowanych jest 5 000 punktów danych to 4 z 5 punktów 

danych zostaną wyeliminowane, a plik wyjściowy zawierać będzie jedynie 1 000 

punktów danych. 
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24 DRUKOWANIE (ZRZUTÓW EKRANU) 

Użytkownik może wydrukować zrzut ekranu włącznie z opisami znajdującymi się w linii 

statusu oraz informacjami wyświetlanymi na przyciskach kontekstowych. Wydruk 

może odbywać się na drukarce dołączonej do oscyloskopu za pomocą interfejsu USB. 

 W celu skonfigurowania drukarki dołączonej do portu USB przyrządu 

należy: 

1. Dołączyć drukarkę USB do portu hosta znajdującego się na panelu 

przednim przyrządu 

2. W celu wywołania menu konfiguracji drukarki należy: 

• Nacisnąć przyciski [Save/Recall] > Print 

• Wybrać opcję Quick Print ([Utility] > Quick Action >Action, 

Quick Print), a następnie nacisnąć przycisk Settings. 

UWAGA: Przyciski kontekstowe w menu Print Config są wyszarzone 

(nieaktywne) dopóki drukarka nie zostanie podłączona do przyrządu 

Tabela 31 Funkcje dostępne w menu Print Config 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Wybór miejsca gdzie 
skierowany zostanie 
wydruk 

Print to, (drukarka) 

Opcje wydruku Dostępne opcje: 

• Setup Information 

• Invert Graticule Color 

• Form Feed 

• Landscape 

Wydruk kolorowy czy w 
skali szarości 

Palette, (Color, Grayscale) 

Wydruk bieżącego 
zobrazowania ekranu 

Press to Print 

 

Jeżeli zdefiniowana została funkcja przycisku [Quick Action] (ustawiono jako Quick 

Print) to wydruk bieżącego zobrazowania ekranu wymaga jedynie naciśnięcie 

przycisku [Quick Action]. 

W celu zapoznania się z najnowszymi informacjami dotyczącymi listy drukarek 

obsługiwanych przez oscyloskopy serii InfiniiVision należy odwiedzić stronę: 

www.keysight.com/find/InfiniiVision-printers. 

  

http://www.keysight.com/find/InfiniiVision-printers
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25 USTAWIENIA WEWNĘTRZNE 

OSCYLOSKOPU 

Poniższa tabela zawiera wykaz dostępnych funkcji służących do modyfikowania 

ustawień wewnętrznych oscyloskopu. 

Tabela 32 Funkcje ustawień wewnętrznych oscyloskopu 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Konfiguracja portu I/O [Utility] > I/O > 

Oscyloskop może być dostępny lub sterowany zdalnie za pomocą portu 

USB znajdującego się na panelu tylnym przyrządu (prostokątny port 

USB). Więcej informacji na ten temat można znaleźć w instrukcji 

programowania oscyloskopu. 

Menadżer plików [Utility] > File Explorer > 

Z wewnętrznego systemu plików w katalogu „\User Files” użytkownik 
może załadować pliki konfiguracyjne oscyloskopu (z 10 rejestrów) lub 
pliki masek (z 4 rejestrów).  

Z dołączonego do portu USB zewnętrznego nośnika danych można 
wgrywać pliki instalacyjne, maski, pliki licencji, pliki aktualizacji 
oprogramowania (*.cab) pliki etykiet i inne. Można również usunąć pliki 
znajdujące się na dołączonym nośniku.  

Prostokątny port USB znajdujący się na panelu przednim przyrządu to 
gniazdo USB typu A, do którego można podłączyć urządzenia pamięci 
masowej USB i drukarki. 

Opcje rozszerzenia skali 
V/div 

[Utility] > Options > Preferences > Expand,  

• Ground  

• Center 

Ustawienie 
przeźroczystości tła 

[Utility] > Options > Preferences > Transparent 

Ustawienie wygaszacza 
ekranu 

[Utility] > Options > Preferences > Screen Saver > 

Ustawienie preferencji dla 
funkcji Autoscale 

[Utility] > Options > Preferences > Autoscale > 

Włączenie szybkiego 
debugowania dla funkcji 
Autoscale 

[Utility] > Options > Preferences > Autoscale > Fast Debug 

Wskazanie kanałów które 
mają mieć włączoną 
funkcję Autoscale 

[Utility] > Options > Preferences > Autoscale > Channels 
(All Channels, Only Displayed Channels) 

Wybór trybu akwizycji 
danych podczas 
wykonywania funkcji 
Autoscale 

[Utility] > Options > Preferences > Autoscale > Acq Mode 
(Use normal acquisition mode, Preserve acquisition mode) 

Zegar oscyloskopu [Utility] > Options > Clock > 
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Czas wyświetlania menu 
przycisków 
kontekstowych 

[Utility] > Options > Menu Timeout 

Informacje o typie sygnału 
wyprowadzanego na 
wyjście Gen Out 

[Utility] > Options > Auxiliary > Gen Out,  

• Triggers  

• Mask  

• WaveGen 

Zabezpieczenie przed 
uruchomieniem kalibracji 

[Utility] > Options > Auxiliary > Cal Protect 

Kalibracja wykonywana 
przez użytkownika 

[Utility] > Service > Start User Calibration 

Wsparcie dla zadań 
serwisowych 

[Utility] > Service >  

Więcej informacji na ten temat można znaleźć w pozycji Keysight 
InfiniiVision 1000X-Series Oscilloscopes Service Guide. Zawiera ona 
również informacje dotyczące: 

• Sposobu czyszczenia oscyloskopu 

• Sprawdzania czasu trwania gwarancji podstawowej i statusów 
jej rozszerzenia 

• Zasad kontaktu z firmą Keysight 

• Zasad przesyłania przyrządu do firmy Keysight 

Status kalibracji 
wykonywanej przez 
użytkownika 

[Utility] > Service > User Calibration Status 

Informacje dotyczące 
wyników wewnętrznego 
testu podzespołów 
przyrządu 

[Utility] > Service > Hardware Self Test 

Informacje dotyczące 
wyników testu 
wyświetlacza 

[Utility] > Service > Front Panel Self Test 

Informacje o oscyloskopie [Help] > About Oscilloscope 

Prezentowane są dane dotyczące: modelu przyrządu, numeru 
seryjnego, pasma pracy, wersji oprogramowania przyrządu 
i zainstalowanych licencji 

Informacje o języku 
interfejsu  

[Help] > Language 

25.1 Urządzenia pomięci zewnętrznej dołączane do portu 
USB 

W celu utworzenia żądanej struktury katalogów na nośniku pamięci dołączanym do 

portu USB oscyloskopu, najlepiej jest wykorzystać zewnętrzny komputer PC. 

Większość zewnętrznych pamięci masowych dołączanych do portu USB oscyloskopu 

jest przez przyrząd obsługiwana. Może się jednak zdarzyć, że dołączone do portu USB 

urządzenie będzie niekompatybilne z oscyloskopem co objawiać będzie się brakiem 

możliwości odczytu i zapisu danych na takim nośniku. Zewnętrzne pamięci USB 
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obsługiwane przez oscyloskop muszą być formatowane z systemem plików FAT lub 

FAT32. 

Po podłączeniu pamięci zewnętrznej do portu hosta USB na ekranie oscyloskopu 

pojawi się mały czterokolorowy okrąg w chwili, gdy odczytywana jest zawartość 

zapisana na nośniku. 

Przed odłączeniem nośnika pamięci od portu USB nie ma konieczności programowego 

odłączania nośnika. Należy po prostu odłączyć nośnik od portu USB. Konieczne jest 

jedynie upewnienie się czy operacje zapisu lub odczytu danych z nośnika zakończyły się.  

Do portu USB oscyloskopu nie należy podłączać urządzeń identyfikujących się jako 

czytniki lub nagrywarki płyt CD, ponieważ urządzenia te z zasady nie są obsługiwane 

przez oscyloskopy serii InfiniiVision. 

25.2 Konfigurowanie przycisku [Quick Action] 

Przycisk [Quick Action] pozwala użytkownikowi na zaprogramowanie obsługi 

prostych, ale często wykonywanych poleceń i wykonywanie ich poprzez naciśnięcie 

jednego przycisku szybkiego wybierania. 

Tabela 33 Funkcje służące do programowania przycisku Quick Action 

Funkcja Przyciski panelu przedniego lub przyciski kontekstowe służące 
do jej wywołania 

Konfiguracja przycisku 
[Quick Action] 

[Utility] > Quick Action > Action,  

• Off • Quick Measure All  

• Quick Mask Statistics Reset 

• Quick Print  

• Quick Save 

• Quick Recall  

• Quick Freeze Display  

• Quick Trigger Mode  

• Quick Clear Display 

Wykonanie przypisanej 
komendy do przycisku 
[Quick Action] 

[Quick Action] 
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26 SPECYFIKACJA I PODSTAWOWE 

CHARAKTERYSTYKI PRZYRZĄDU 

W celu zapoznania się z najświeższą specyfikacją oscyloskopów serii 1000 X i jego 

charakterystykami należy zapoznać się z danymi zawartymi na stronie: 

www.keysight.com/find/1000X-Series  

26.1 Warunki środowiskowe pracy i przechowywania 
przyrządu 

Miejsce pracy Do użytku wewnątrz pomieszczeń 

Temperatura otoczenia Praca w temperaturach od 0°C do +50°C 

Przechowywanie w temperaturach od -40°C do +71°C 

Wilgotność Praca przy wilgotności względnej od 50% do 95% przy temperaturze 40°C 

przez 5 dni 

Przechowywanie przy wilgotności względnej nawet do 90% przy 

temperaturze do 65°C przez 24 godziny 

Wysokość Praca przy wysokości do 3 000 m 

Przechowywanie do wysokości 4 000 m 

Kategoria przepięciowa Przyrząd został zaprojektowany tak, że jego zasilanie odbywa się przez 

przewód zasilania odpowiadający kategorii przepięciowej II, co jest 

typowe dla urządzeń do których zasilanie doprowadzone jest za pomocą 

przewodu i wtyczki. 

Stopień zanieczyszczeń Oscyloskopy serii InfiniiVision serii 1000 X mogą pracować w warunkach 

zanieczyszczeń II lub I stopnia  

Definicja stopni 

zanieczyszczenia 

powietrza 

Zanieczyszczenia I stopnia: Nie ma zanieczyszczeń lub występują tylko 

zanieczyszczenia suche, nieprzewodzące. Zanieczyszczenia takie nie 

maja wpływu na pracę przyrządu. Przykład: Czyste pomieszczenie lub 

środowisko biurowe. 

Zanieczyszczenia II stopnia: Zwykle występują tylko suche 

zanieczyszczenia nieprzewodzące. Czasem może dojść do 

przejściowego przewodnictwa tych zanieczyszczeń spowodowanego 

występowaniem kondensacji. Przykład: ogólne środowisko wewnętrzne. 

Zanieczyszczenia 3 stopnia: Występują zanieczyszczenia przewodzące 

lub zanieczyszczenia suche, które z uwagi na występującą kondensację 

zmieniają swój charakter na zanieczyszczenia przewodzące Przykład: 

zadaszone otoczenie zewnętrzne. 

26.2 Deklaracja zgodności 

Deklaracja zgodności produktu umieszczona jest na stronie producenta pod adresem: 

www.keysight.com/go/conformity  

http://www.keysight.com/find/1000X-Series
http://www.keysight.com/go/conformity
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27 SONDY I AKCESORIA 

Lista sond i akcesoriów kompatybilnych z oscyloskopami serii 1000 X dostępna jest 

pod adresem www.keysight.com/find/1000X-Series  

Ponieważ oscyloskopy serii 1000X nie posiadają pierścienia ze stykami elektrycznymi 

wokół gniazd wejść analogowych zapewniających prawidłową identyfikację dołączanej 

sondy, użytkownik musi samodzielnie, ręcznie ustawić wartość tłumienia. 

Więcej informacji na temat sond i akcesoriów można znaleźć na stronach firmy 

Keysight pod adresem: www.keysight.com oraz w notach technicznych: 

• Probes and Accessories Selection Guide (5989-6162EN)  

• InfiniiVision Oscilloscope Probes and Accessories Selection Guide Data Sheet 

(5968-8153EN)  

• Informacje na temat kompatybilności, instrukcji obsługi, not aplikacyjnych, 

katalogów danych, modeli SPICE, a także szerszych informacji dotyczących 

sond oscyloskopowych można znaleźć na stronie www.keysight.com/find/PRC 

Probe Resource Center. 

 

  

http://www.keysight.com/find/1000X-Series
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28 AKTUALIZACJA OPROGRAMOWANIA 

WEWNĘTRZNEGO PRZYRZĄDU 

Od czasu do czasu firma Keysight Technologies publikuje aktualizacje 

oprogramowania wewnętrznego swoich produktów. Informacje o takich aktualizacjach 

publikowane są na stronie www.keysight.com/find/1000X-Series-sw. 

Aby wyświetlić informacje o aktualnie zainstalowanym oprogramowaniu wewnętrznym 

i oprogramowanie aplikacyjnym przyrządu, naciśnij przycisk [Pomoc] > About 

Oscilloscope 

Po pobraniu pliku aktualizacyjnego oprogramowania można nagrać go na zewnętrzną 

pamięci masową USB i wgrać plik do oscyloskopu przy użyciu Eksploratora plików 

 

 

 

http://www.keysight.com/find/1000X-Series-sw
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